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Предисловие 

Учебно-методическое пособие содержит типовые задачи по основным 

темам третьей части учебной дисциплины «Математика. Математический 

анализ» для студентов, получающих высшее образование по специальности  

1-40 04 01 «Информатика и технологии программирования». Студенты 

должны уметь решать их аналитическими методами и контролировать 

полученные результаты с помощью программных инструментов и средств 

системы компьютерной алгебры (СКА) Maple.  

Первая лабораторная работа предназначена для контроля достигнутых 

навыков работы в системе Maple, конкретнее – в ее восемнадцатой версии под 

управлением операционной системы Windows. Однотипные десятивариантные 

задания сгруппированы в восемь тематических лабораторных работ (со второй 

по девятую). 

Условия заданий с перечнем основных тем для самоконтроля 

сформулированы в третьей главе данного пособия. Для выполнения всех 

лабораторных работ имеется необходимый справочный материал по работе с 

системой, который можно найти в первой главе учебно-методического пособия, 

и упражнения для тренировки с комментариями к их выполнению, 

предлагаемые во второй главе. 

Более подробная информация по работе в системе компьютерной алгебры 

Maple содержится в книгах [1‒12]. При составлении заданий были 

использованы материалы учебных пособий [13‒17]. 
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1. Основные математические объекты и операции в Maple 

 

Maple − одна из лидирующих систем для выполнения символьных 

преобразований математических выражений, проведения численных расчетов с 

очень большой степенью точности, обработки данных и визуализации 

результатов. К настоящему времени программа, ежегодно обновляясь, 

превратилась в мощный вычислительный комплекс, предназначенный для 

реализации сложных научно-технических проектов и моделирования. 

Интуитивно понятный алгоритмический язык Maple позволяет 

программировать решение задач при отсутствии в системе нужной встроенной 

команды и создавать пользовательские библиотеки. Наличие отличного 

редактора предоставляет возможность получения документа с высоким 

полиграфическим качеством. Графические встроенные объекты позволяют 

создавать полезные интерактивные приложения. Анимационные возможности и 

мощная графика способствуют более глубокому пониманию важных научных 

понятий, формул и законов. 

Функционально СКА состоит из ядра, выполняющего основные 

математические операции, библиотеки процедур-функций, 

специализированных пакетов и разных типов интерфейса. 

1.1. Структура окна стандартного интерфейса 

При запуске Maple 18 как Windows-приложения открывается окно со 

стандартным графическим интерфейсом программ, работающих под 

управлением операционных систем этого семейства, и открытой стартовой 

страницей (файл start.mw).  

Прямоугольное поле стартовой страницы разделено вертикальной линией 

на две части, в которых содержатся кнопки для быстрых действий. Четыре 

кнопки слева помогут пользователю выбрать шаблон для создания нового 

файла (New Document или New Worksheet) или изучить справочную 
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документацию системы (Getting Started и Help), кнопки справа ‒ найти 

образцы готовых примеров для реализации своего проекта (Calculus, 

Mathematics и др.). Дизайн и содержимое стартовой страницы могут 

редактироваться. 

Для запуска Maple-сессии нужно произвести одно из следующих 

действий: 

1) на стартовой странице выбрать New Document (Новый документ) или 

New Worksheet (Новый рабочий лист); 

2) из меню File выбрать New, а затем или Document Mode, или 

Worksheet Mode. 

При открытии файла в режиме Document Maple выводит окно Quick Help 

(Быстрая Помощь) со списком некоторых важных «горячих» клавиш, которое 

автоматически сворачивается после начала работы. Для быстрого вызова 

полной или краткой справки в дальнейшем можно использовать в любом 

режиме управляющие клавиши <f1> или <f2> соответственно (или <ctrl><f1>, 

<ctrl><f2>). Возвращение на стартовую страницу возможно с помощью 

нажатия кнопки  панели инструментов. 

Таким образом, существует два основных режима работы стандартного 

интерфейса: Document и Worksheet. Их подробное описание можно найти во 

встроенном в систему учебнике User Manual (Руководство пользователя) через 

установку действий из главного меню: Help → Manuals, Resources, and  

more → Manuals → User Manual. 

Из каждого режима есть доступ к нужным для поставленных целей 

технологиям Maple. Главное же отличие связано с формой ввода и вывода 

информации, установленной по умолчанию, и результатами работы 

контекстного меню. Шаблон Document использует Document Blocks (Блоки 

документа), которые при вводе частично скрывают синтаксис команд языка 

Maple. Например, при использовании контекстного меню, которое вызывается 

нажатием правой кнопки мыши при ее наведении на объект области ввода, 
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появляется лишь стрелка с именем нужной команды, связывающая ввод и 

вывод. Сам текст кода, использующийся для решения вызванной задачи, скрыт. 

Области блоков выделяются двумя треугольниками в вертикальном указателе 

слева от рабочего поля документа. По умолчанию они отключены, а сама 

область ввода выделяется пунктирными линиями в форме прямоугольника. Для 

того чтобы треугольники увидеть, нужно в главном меню открыть вкладку 

View и выбрать Markers. Режим Document включается также при создании 

нового файла путем нажатия кнопки  на панели инструментов. 

Режим Worksheet использует по умолчанию символ приглашения . 

Угол красного цвета <>> расположен справа от квадратной скобки, которая 

увеличивается по мере ввода символов. При вызове контекстного меню для 

объекта в этом режиме текст выбранных команд автоматически прописывается 

на экране в области ввода. Скрывать текст в режиме Worksheet тоже можно, 

добавив блок документа из меню Format главного меню: Format → Create 

Document Block, или, наоборот, можно показать команды в режиме Document, 

добавив приглашение командной строки из вкладки Insert в главном меню: 

Insert → Execution Group → Before/After Cursor. Эти переключения режимов 

можно осуществлять также с помощью кнопок панели инструментов: , . 

Таким образом, главным основанием для выбора режима работы 

стандартного интерфейса при решении математических задач является 

необходимость видеть полный текст команд или скрывать некоторые их части 

при работе с контекстным меню. Следует также заметить, что в режиме 

Document при программировании некоторые команды недоступны.  

Окно стандартного интерфейса при создании нового файла в режиме 

Worksheet ‒ это типичное окно ОС Windows, в котором можно выделить 

несколько основных частей. В верхней части под Заголовком окна находится 

строка Главного меню, содержащая список возможных действий в системе 

Maple. Некоторые его части недоступны, пока на рабочем поле не появится 

соответствующий объект. 
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Краткое описание пунктов главного меню: 

File (Файл)  содержит стандартный набор команд для работы с файлами 

(сохранить файл, открыть файл, создать новый файл и т. д.); 

Edit (Редактирование)  содержит стандартный набор команд для 

редактирования текста (копирование, удаление выделенного фрагмента в буфер 

обмена, отмена команды и т. д.); 

View (Вид) – содержит стандартный набор команд, управляющих 

структурой и содержимым видимой части окна интерфейса Maple (панели 

инструментов, секции, маркеры блоков документа и т. д.); 

Insert (Вставка) – содержит стандартный набор команд для вставки полей 

разных типов (для ввода команд в разных режимах, для графических двух- и 

трехмерных изображений, для рисования, для ввода программного кода и т. д.); 

Format (Формат) – содержит стандартный набор команд для оформления 

документа (установка типа, размера и стиля шрифта); 

Tools (Инструменты) – содержит стандартный набор команд для вызова 

различных Maple-средств и установки (переустановки) параметров; 

Windows (Окна) – содержит стандартный набор команд для перехода из 

одного рабочего листа в другой, а также для управления их расположением на 

экране; 

Help (Справка) – содержит стандартный набор команд для вызова разных 

видов справочной документации Maple. 

Ниже строки главного меню расположена Панель инструментов с 

кнопками, дублирующими часто используемые его команды. 

Назначение кнопок и соответствующие им команды: 

 − создать новый файл в режиме Document (File → New → 

DocumentMode); 

 − открыть существующий файл (File → Open …); 
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 − сохранить текущий файл с уже заданным именем (File → Save); 

 − распечатать текущий файл (File → Print…); 

 − открыть предварительный просмотр текущего файла (File → 

Print Preview…); 

 − вырезать выделенную часть файла в буфер обмена (Edit → Cut); 

 − скопировать выделенную часть файла в буфер обмена (Edit → 

Copy); 

 − вставить информацию из буфера обмена в указанное курсором 

место текущего файла (Edit → Paste); 

 − отменить последнее действие (Edit → Undo Insert Text); 

 − вернуться к последнему действию (Edit → Redo Insert Text); 

 − вставить область для ввода программного кода (Insert → Code Edit 

Region); 

 − вставить область для ввода текстового комментария (Insert → 

Text); 

 − вставить область для ввода командной строки в режиме 2D-Math с 

приглашающим символом после текущей группы вычислений (Insert → 

Execution Group → After Cursor); 

 − вставить область для ввода командной строки в режиме 2D-Math 

без приглашающего символа после текущей группы вычислений (Format → 

Create Document Block) или выделенную часть преобразовать в блок типа 

Document; 

 − открыть стартовую страницу (активировать кнопку start.mw в 

строке названий открытых файлов); 
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 − выполнить все команды текущего документа (Edit → Execute → 

Worksheet); 

 − выполнить команды всех выделенных групп вычислений 

документа (Edit → Execute → Selection); 

 − остановить выполнение текущей операции; 

 − очистить внутреннюю память Maple (команда restart); 

 − регулировать масштаб текста текущего документа (View → 

Zoom Factor → …); 

 − открыть справочную систему в новом окне (Help → Maple Help); 

 − строка для ввода поискового запроса 

справочной системе (Help → Maple Help). 

Контекстная панель инструментов изменяется в зависимости от того, в 

какой области рабочего поля находится курсор и что в этой области 

отображается. Существует шесть видов контекстных панелей инструментов для 

следующих областей: ввода и вывода текущего документа в текстовом или 

математическом режимах, рисования, плоского, пространственного и 

анимационного графиков. 

Большую часть окна занимает Рабочее поле документа, содержащее 

команды, результаты их выполнения, текст, графику и другие объекты. Вся эта 

информация может быть отформатирована нужным образом, структурирована 

и оформлена как электронный документ с открывающимися или 

закрывающимися элементами списка содержания. Во время работы для любого 

объекта документа, щелкнув правой кнопкой мыши в его зоне, можно 

отобразить Контекстное меню, команды которого динамически генерируются 

в зависимости от выбранной области. Для более детального ознакомления с 

этим инструментом можно обратиться к справочной системе. 
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Кроме непосредственного ввода команд с помощью клавиатуры, можно 

использовать Палитры, содержащие наборы шаблонов для ввода некоторых 

команд и объектов Maple. Более 20 их видов расположены в левой части 

экрана. Они могут быть в свернутом или развернутом виде. 

Интерфейс Maple является многодокументным, позволяющим открывать 

и работать одновременно с несколькими файлами, в том числе и справочными, 

при необходимости связывая рабочие документы посредством гиперссылок.  

По умолчанию в новом документе ввод команд Maple осуществляется в 

привычной математической записи формул 2D Math (типографское 

изображение). Это отображается на контекстной панели подсветкой поля со 

словом Math и наклонным видом курсора. Переключение режима ввода 

команды в текстовый формат осуществляется нажатием на поле со словом Text 

(оно выделится при этом). Кроме того, для переключения формата ввода можно 

использовать управляющую клавишу <f5>. Активация кнопки  на основной 

панели инструментов переведет курсор на следующую строку после последней 

группы вычислений и переключит математический режим ввода команд в 

режим ввода текстовых комментариев, которые не обрабатываются 

интерпретатором Maple. При этом курсор принимает вертикальное положение. 

Текстовые комментарии можно вводить и в режиме командной строки, начиная 

их символом <#>. 

Режим Worksheet требует записи команд построчно в группах (группа 

может содержать и одну команду), а результат выполнения выводится в 

следующей за группой строке. При этом приглашающий символ отображается 

при распечатке файла. В обоих режимах сохранилась возможность ввода 

команды в виде, присущем ранним версиям Maple (Maple Input, или 1D Math). 

В этом случае отображение символов на экране идет красным цветом (если не 

изменены системные настройки), и завершение каждой команды знаками <;> 

или <:> строго обязательно. Оператор  <;> означает, что результат выполнения 

соответствующей команды появится в области вывода после ее обработки. 
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Фиксатор <:> используется для подавления вывода на экран, т. е. переводит 

команду в ее инертное выполнение. 

Для создания качественного электронного документа из вкладки Insert 

главного меню можно выбрать специальный объект Section (Секция) (или 

использовать две специальные кнопки основной панели инструментов), 

который представляет собой серый треугольник с вертикальной скобкой, 

ограничивающей группу вычислений и текстовых строк. При нажатии на 

треугольник информация сворачивается, а сам он приобретает направление 

вправо, подчеркивая тем самым наличие содержания. Повторное нажатие 

приводит к разворачиванию содержимого. Более подробно изучить 

возможности форматирования можно, воспользовавшись справочной системой. 

Системные настройки можно изменить, выбрав из заголовка Tools 

главного меню вкладку настроек Options. 

Во время сессии пользователь вводит предложения (выражения, команды, 

процедуры, текст и т. п.), которые обрабатывает система Maple. Рабочее поле 

при этом разделяется на две части: 

‒ область ввода, состоящую из командных строк и текстовых 

комментариев; 

‒ область вывода, содержащую результаты обработки введенных команд 

в виде аналитических выражений, графических объектов или сообщений об 

ошибках. 

Область текстовых комментариев не воспринимается и не обрабатывается 

Maple. 

Область ввода и соответствующая ей область вывода называются группой  

вычислений. На рабочем листе она отмечается квадратной скобкой слева. В 

группе вычислений может содержаться несколько команд и операторов: все они 

обрабатываются системой за одно обращение при нажатии клавиши <enter>. 

Одна команда, введенная в математическом режиме, может подаваться 

сразу на выполнение клавишей <enter>. При этом, если она завершается 
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фиксатором <;> конца записи, то результат выводится на экран. Если фиксатор 

отсутствует, то интерпретатор автоматически добавляет его. Для подавления 

вывода на экран результатов работы команды ее следует завершить двоето-

чием <:>. Перевод на следующую строку при вводе команд одной группы 

вычислений осуществляется парой клавиш <shift><enter>. При этом, если 

команды отделены друг от друга точкой с запятой, вывод будет осуществлен в 

порядке их следования со строки, следующей за последней командой группы. 

Если же фиксатор <;> пропущен, то вывод может быть неожиданным или 

соответствовать последней выведенной команде. Так как Maple имеет общую 

внутреннюю память, для корректности работы новую задачу на текущем 

рабочем листе рекомендуется начинать командой restart, которая очищает все 

регистры и отключает все подключенные библиотеки. Аналогичное действие 

совершается при помощи соответствующей кнопки  панели инструментов. 

При работе в текстовом режиме клавиша <enter> переводит запись на 

следующую строку, никакой результат при этом не выводится. 

Большое количество математических расчетов в Maple 18 можно 

проводить без непосредственного прописывания инструкций (например, 

используя контекстное меню или специализированные браузеры), но все его 

возможности и преимущества сосредоточены в командах и средствах 

программирования. 

В командную строку можно записать любое алгебраическое выражение. 

После нажатия клавиши <enter> или кнопки с одним восклицательным знаком 

на инструментальной панели она будет обработана системой, а результат 

выведен на экран (если завершить двоеточием, вывод на экран будет подавлен). 

Если команда содержит синтаксические ошибки или ошибки выполнения, 

то система в области вывода напечатает сообщение об их характере. Для 

корректировки можно в любой момент вернуться к оператору, исправить его и 

снова подать на выполнение. 



14 

 

Библиотека Maple 18 состоит из двух основных частей: главной 

библиотеки, содержащей встроенные функции и команды, и библиотеки 

специализированных пакетов. Список всех команд главной библиотеки можно 

получить по пути Help → Manuals, Resources, and more → List of Commands, 

а список пакетов – по пути Help → Manuals, Resources, and more → List of 

Packages. 

Ввод стандартной команды Maple в режиме 2D Math по умолчанию 

отображается черным шрифтом и имеет вид Имя_команды(аргументы, 

параметры), где Имя_команды – ключевое слово команды, аргументы, 

параметры – соответственно ее обязательные и дополнительные аргументы. 

Для вызова команды из пакета существует два варианта: загрузить весь пакет с 

помощью команды with(Имя_пакета) и далее использовать обычный формат 

записи команды или вызвать команду без подключения всего пакета с 

помощью длинной формы ее записи: Имя_пакета[Имя_команды](аргументы, 

параметры). 

Удобно для первоначального ознакомления с командами пакета не 

завершать команду его подключения двоеточием. В этом случае их полный 

список выведется на экран. Далее можно, выделив нужную команду, 

скопировать ee имя в указанное курсором место рабочего листа. 

Доступ к документации Maple обеспечивает вкладка Help (Справка) 

главного меню. В основу справочной системы положено понятие гипертекста, 

состоящего из тысяч связанных страниц, что позволяет быстро найти полную 

информацию по необходимому вопросу. 

Для вызова справки можно использовать одно из следующих действий: 

1) из главного меню выбрать вкладку Help → Maple Help; 

2) нажать комбинацию клавиш <ctrl><f1>; 

3) ввести в окошке основной панели инструментов слово для поиска; 

4) нажать кнопку  основной панели инструментов; 



15 

 

5) подвести курсор к нужной команде, вызвать контекстное меню 

нажатием правой кнопки мышки и выбрать во всплывшем окне строку Help On 

Command. 

В любом из перечисленных вариантов откроется окно справочной 

системы, разделенное на две вертикальных части: левая часть состоит из 

окошка для ввода поискового запроса и раскрывающегося краткого содержания 

справочной системы, справа – вывод информации по введенному запросу или 

выбранному пункту интерактивного содержания. 

Около названий пунктов содержания на левой панели можно заметить 

значки. Приведем их значение: 

 + − означает наличие подпунктов соответствующего пункта; 

 ? − указывает на страницу справки, которая появится на правой панели; 

 WS − означает, что откроется рабочий лист с примерами; 

 D − откроется страница справки с определениями понятий; 

 T − примеры решения задач (их можно вызвать также из главного меню 

Tools → Tasks → Browse…). 

Примеры, приведенные в справочной системе, можно выполнить, открыв 

вкладку View → Open Page as Worksheet или скопировав нужную их часть в 

свой рабочий лист. 

В справочной системе, кроме информации по работе с самой системой, 

можно найти математические и инженерные словари, содержащие более 5000 

понятий и около 300 рисунков и графиков. Выход в Интернет дает возможность 

связаться с имеющимися в сети источниками нужной информации, в частности, 

связаться с главным сайтом производителя http://www.maplesoft.com. 

1.2. Числа и действия над ними 

Действительные (real) числа можно вводить и получать в разных 

форматах. Для целых чисел – тип integer – это обычный ввод 

последовательности цифр десятичной системы счисления, начинающейся 

http://www.maplesoft.com/
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минусом для отрицательных чисел: 2, 42, 0, −372. Рациональные числа могут 

быть заданы несколькими способами. Прежде всего, это запись в виде 

отношения двух целых чисел: 2/5, 79/8, −142/2. Maple при выводе сразу 

упрощает результат до несократимой дроби или целого числа. При записи 

числа в виде конечной десятичной дроби – тип float – в качестве разделителя 

целой и дробной частей используется точка: 24.42, 0.64 или просто .64 в случае 

нулевой целой части. Число выведется в показательной форме, если его 

записать как произведение десятичной дроби на степень с натуральным 

показателем по основанию 10. При этом мантисса приведется к стандартному 

виду (число из диапазона от 1 до 10) формата float c округлением до значения, 

определяемого текущим значением системной переменной Digits. По 

умолчанию ее значение равно 10. Наконец, точные иррациональные числа 

(радикалы 1/nm  или n m ) и трансцендентные числа, не являющиеся целыми 

алгебраическими (, е и др.), представляются своей символьной записью. 

Система Maple поддерживает точное представление чисел, хотя для 

десятичной нотации чисел имеется практически неограниченное число 

разрядов. Выяснить его значение можно с помощью команды 

kernelopts(maxdigits). В последних версиях системы оно достигает сотен 

миллионов, точнее, 268 435 448 в 18-й  версии. Maple стремится оперировать 

именно с точными (символьными) представлениями. «Вынудить» ее перейти к 

приближенным значениям можно только специально, в частности, применяя 

функцию evalf(). Команда evalf может иметь следующий формат ввода: 

evalf(expr), evalf(expr, n) или evalfn(exrp), 

где expr – выражение, для которого нужно найти приближенное значение; 

       n – количество значащих цифр в записи результата (необязательный 

параметр, по умолчанию равный 10). 

Для записи символов в нижнем регистре можно использовать сочетание 

клавиш <shift><ctrl><->. Переход к приближенным значениям лучше 

выполнять уже для конечного результата. 
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Полезным часто оказывается унарный оператор %, который обращается к 

результату предыдущей команды. Возможны еще две его версии, а именно: %% 

и %%%  (для обращения к результатам ранее выполненных команд). 

Ввод арифметического выражения осуществляется естественным 

способом с учетом круглых скобок и приоритета операций. Знаки самих 

арифметических операций вводятся согласно табл. 1 и при наборе в режиме  

2D Math автоматически преобразуются в привычную формульную запись. При 

вводе в формате Maple Input (текстовый набор командной строки) вводимые 

символы не преобразуются. 

Таблица 1 

Арифметические операции 

 

Для ввода команд можно использовать шаблоны из палитры Expressions. 

Для этого нужно щелкнуть по определенной кнопке, чтобы необходимый 

шаблон появился в области ввода, а затем ввести в выделенные места значения 

переменных. При наборе можно использовать клавишу навигации <→> для 

выхода из зоны набора, например, знаменателя или показателя степени. 

Следует знать, что запись отношения двух целых чисел в виде обыкновенной 

дроби автоматически преобразуется в несократимую дробь. 

При вводе математических констант (табл. 2) можно использовать или их 

непосредственный набор по правилам Maple, или применять палитры.  

Операция Клавиша Ввод Вид 

Сложение + 24+42 24 42  

Вычитание − 24−42 24 42  

Умножение * 24*42 24 42  

Деление / 
24/42 24

42  

Возведение в 

степень 
^ 

24^42 4224  
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Таблица 2 

Математические константы 

Константа Набор клавиш 

π  Pi 

i (мнимая единица) I 

  Infinity 

e ( число Непера) exp(1) 

γ  (константа Эйлера) gamma 

логические 1 и 0 true, false 

 

При наборе с клавиатуры символ e воспринимается как обычная 

переменная. Поэтому для числа e используется ввод с помощью встроенной 

функции exp(x) или с помощью шаблона из палитры Expressions. Для того 

чтобы значения трансцендентных функций от целых аргументов выводились в 

числовом формате (т. е. в виде приближенного числа), можно при их вводе 

использовать десятичную точку. 

Для записи греческих букв в полиграфическом виде можно использовать 

специальную палитру Greek или команду, соответствующую нужной букве 

(табл. 3). При наведении указателя мыши на нужную букву в палитре 

«всплывает» подсказка с ее командой. Для ввода заглавной греческой буквы 

следует начинать ввод с прописной буквы (alpha – Alpha). В области ввода 

отобразится команда, а в области вывода − соответствующая буква. 

Исключение составляют математические константы π  и γ , для которых 

используются команды Pi и gamma соответственно. 

 



19 

 

Таблица 3 

Греческие буквы (строчные) 

Печатная 

буква 

Команда 

в Maple 

Печатная 

буква 

Команда 

в Maple 

Печатная 

буква 

Команда 

в Maple 

Печатная 

буква 

Команда 

в Maple 

α  alpha η  eta μ  mu σ  sigma 

β  beta θ  theta ν  nu φ  phi 

δ  delta ι  iota ξ  xi χ  chi 

ε  epsilon κ  kappa π  pi ψ  psi 

ζ  zeta λ  lambda ρ  rho ω  omega 

 

Основные элементарные математические функции входят в стандартную 

библиотеку Maple и вводятся в привычном формате function(argument). Их 

перечень приведен в табл. 4. Слева приводится математическая запись, справа – 

запись в Maple. При этом выводится главное значение функции, поскольку 

система работает в поле комплексных чисел. При необходимости рассмотрения 

функций действительного аргумента можно подключить специализированный 

пакет RealDomain.  

Таблица 4 

Встроенные математические функции 

Функция Команда 

в Maple 

Функция Команда 

в Maple 

Функция Команда 

в Maple 

Функция Команда в 

Maple 

x  sqrt(x) loga x  log[a](x) sec x sec(x) arcctg x arcccot(x) 

|x| abs(x) sin x sin(x) cosec x csc(x) sh x sinh(x) 

xe  exp(x) cos x cos(x) arcsin x arcsin(x) ch x cosh(x) 

ln x  ln(x) tg x tan(x) arccos x arccos(x) th x tanh(x) 

lg x  log10(x) ctg x cot(x) arctg x arctan(x) cth x coth(x) 

 

Для тригонометрических функций часто бывает необходимо 

представление аргумента в разных формах: радианной или градусной. Для 
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перевода из одной меры в другую можно использовать универсальную команду 

преобразования convert(). Для перевода в градусную меру требуется формат 

convert(number, degrees) записи команды, где number – радианное значение, а 

для обратной задачи − convert(number degrees, radians), где number – градусное 

значение. 

Комплексное (complex) число z записывается в алгебраической форме как 

z x iy  . В командной строке такая запись должна вводиться так: z:=x+I*y. 

Функции Re(z) и Im(z) возвращают действительную и мнимую части 

комплексного числа z, а функции abs(z) и argument(z) вычисляют его модуль и 

главное значение аргумента соответственно. Модуль и главное значение 

аргумента в диапазоне ( π, π]  комплексного выражения z можно найти 

одновременно и с помощью команды polar(z). 

Комплексно-сопряженное число z x iy   выводится с помощью команды 

conjugate(z). 

Если комплексное выражение очень сложное или содержит параметры, то 

команды Re(z) и Im(z) могут не выдать требуемого результата. Получить 

вещественную и мнимую части комплексного выражения z в этом случае 

можно попробовать с помощью команды преобразования комплексных 

выражений evalc(z), которая возвращает упрощенное выражение в 

алгебраической форме. 

 

1.3. Простейшие операции с выражениями 

Maple обладает широкими возможностями для проведения аналитических 

преобразований математических выражений. К ним относятся такие операции, 

как приведение подобных одночленов, разложение на множители, раскрытие 

скобок, разложение алгебраической дроби на сумму простейших и др. 
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Выделение частей выражения 

Математическая формула, над которой будут производиться 

преобразования, обычно записывается в следующей форме:  

>eq:expr1   expr2, 

где eq – назначенное имя (идентификатор) выражения; 

       :  ‒ оператор присваивания; 

       expr1 – условное обозначение левой части формулы; 

       expr2 – условное обозначение правой части формулы. 

Выделение правой части выражения eq осуществляется командой rhs(eq), 

левой части – командой lhs(eq). 

Если задана рациональная дробь вида m/n, то можно выделить ее 

числитель и знаменатель соответственно командами numer(m/n) и denom(m/n). 

Тождественные преобразования 

1. Раскрытие скобок в выражении expr осуществляется командой     

expand(expr). Кроме того, можно с помощью этой команды провести почленное 

деление числителя на знаменатель в алгебраической дроби. 

Эта команда имеет дополнительные параметры, позволяющие при 

раскрытии скобок оставлять определенные выражения без изменения, а также 

поддерживает большое количество специальных математических функций 

(см. Help – поддержку в документации Maple).  

2. Разложение выражения expr (в частности, многочлена) на множители 

осуществляется командой factor(expr). 

Иногда не удается с помощью этой команды разложить на множители 

числовое выражение. В этом случае можно попробовать решить задачу с 

переменными величинами, а затем подставить вместо них нужные значения. В 

случае, когда разложение на множители некоторых тригонометрических 

выражений с помощью этой команды невозможно, применение команды expand 

иногда помогает решить проблему. 
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3. Алгебраическую дробь expr можно привести к несократимой с 

помощью команды normal(expr). 

4. Универсальная команда упрощения выражений − simplify(expr). В 

качестве дополнительных параметров можно указать, какие типы выражений 

нужно преобразовывать. 

Стандартные параметры: 

- trig – преобразование тригонометрических выражений; 

- power –  преобразование степенных выражений; 

- radical или sqrt – преобразование иррациональных выражений; 

- exp – преобразование показательных выражений; 

- ln – преобразование логарифмических выражений. 

Использование параметров намного увеличивает эффективность этой 

команды. Для ограничения области вычислений можно применять специальный 

пакет RealDomain, в котором используются только действительные числа, или 

команды assume и assuming (более подробно изучить их назначение позволит 

справочная система Maple). 

5. Приведение подобных членов в выражении осуществляется командой 

collect(expr, var), где expr – выражение, var – имя переменной, относительно 

которой следует проводить преобразование. 

6. Для упрощения выражений, содержащих не только квадратные корни, 

но и корни других степеней, лучше использовать команду radnormal(expr). 

7. С помощью универсальной команды convert(expr, param) 

осуществляется преобразование выражения expr в указанный тип param.  

В частности, можно привести тригонометрическое выражение, 

содержащее sin x и cos x, в выражение, содержащее только tg x, если указать в 

качестве параметра param значение tan, или, наоборот, содержащее tg x, ctg x 

можно перевести в sin x и сos x, если в параметрах указать sincos. Для 

разложения алгебраической дроби на сумму простейших можно указать 

параметр parfrac. 
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Вообще, команда convert имеет более широкое назначение. Она 

осуществляет преобразование выражения одного типа в другой. Например: 

convert(list, Vector) – преобразование некоторого списка list в вектор с теми же 

элементами; convert(expr, string) – преобразование математического выражения 

в его текстовую запись. 

8. Для проверки истинности тождества expr можно применить команду 

testeq(expr). 

Полную информацию о командах можно найти в документации Maple 

(см. поддержку Help). 

1.4. Решение уравнений, неравенств и их систем 

Решение алгебраических уравнений 

Для решения уравнений в Maple существует универсальная команда 

solve(eq, x), где eq – уравнение, x – переменная, относительно которой его надо 

решить. В результате выполнения этой команды в строке вывода появится 

выражение, которое является решением данного уравнения. 

Если уравнение имеет несколько решений, которые понадобятся для 

дальнейших расчетов, то команде solve можно присвоить имя name. Обращение 

к k-му решению данного уравнения производится указанием его имени с 

номером решения k в квадратных скобках: name[k]. 

Функция solve проводит решение в аналитическом виде, которое обычно 

имеет символьный вид. Для получения числовых значений корней (точнее, их 

приближенных значений) можно использовать функцию evalf или записывать 

числовые коэффициенты уравнения в формате с плавающей точкой. 

Решение тригонометрических уравнений 

Команда solve, примененная к тригонометрическому уравнению, выдает 

только главные решения, т. е. в интервале ( π; π] . Для того чтобы получить все 

решения, следует в аргументах команды прописать опцию allsolutions. 
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Решение систем уравнений 

Систему уравнений в Maple можно решить также с помощью команды 

solve, но в формате solve({eq1, eq2,…}, {x1, x2,…}). Аргументы команды ‒ 

уравнения и переменные, относительно которых требуется решить систему, 

указанные соответственно в первой и во второй паре фигурных скобок через 

запятую. Если необходимо для дальнейших вычислений использовать 

полученные решения уравнений, то команде solve следует присвоить имя name 

с помощью оператора присваивания или команды assign(name). После этого над 

решениями можно производить математические операции. 

Если Maple не может получить корни уравнения или системы уравнений 

в радикалах, в ответе появляется функция RootOf. Для получения ответа в 

явном виде можно использовать команду allvalues(expr). 

Для численного решения уравнений и их систем в тех случаях, когда они 

не имеют аналитических решений (или когда система Maple не смогла найти 

решение в виде действительного числа), используется специальная команда 

fsolve(), параметры которой такие же, как у команды solve. Если нет 

действительных решений, то в поле вывода продублируется запись команды. 

При необходимости найти возможные комплексные решения следует 

прописать в аргументах команды опцию complex. 

Решение трансцендентных уравнений 

При решении трансцендентных уравнений для получения решения в 

явном виде перед командой solve можно ввести дополнительную команду 

_EnvExplicit: true, которая присваивает системной переменной логическое 

значение «истина». Это является указанием к нахождению решений в явном виде.  

Решение уравнений в целочисленном виде  

Если нужен результат в целых числах, то можно использовать функцию 

isolve( ( ),f x x ). 
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Решение неравенств 

Команда solve применяется как для решения уравнений, так и для 

решения неравенств. Решение неравенства выдается в виде интервала, в 

котором могут изменяться искомые значения переменной. В случае когда 

решением неравенства является полуось, в поле вывода можно увидеть 

конструкцию вида RealRange(–, Open(a)), которая означает, что x(–, a). 

Ключевое слово Open означает, что луч открытый. Если этого слова нет, то 

начало луча включено во множество решений. 

Если нужно получить решение неравенства не в виде интервального 

множества, а в виде ограничений для искомой переменной, то переменную, 

относительно которой следует разрешить неравенство, следует указывать в 

фигурных скобках. 

Решение систем неравенств 

Систему неравенств можно также решить с помощью команды solve, 

изменив немного формат ввода ее аргументов: solve({ineq1, ineq2,…},  

{x1, x2,…}). 

1.5. Функции и операции над ними 

Способы задания функций в Maple 

1. С помощью функционального оператора-стрелки, который ставит в 

соответствие упорядоченному набору переменных (x1, …, xn) выражение expr, 

от них зависящее. Это соответствие можно задать, например, так: 

f:   (x1, …, xn) –> expr. 

Здесь стрелка вводится с помощью последовательного нажатия клавиш 

<-><>> или выбора из палитры Arrows. При этом варианте задания получить 
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значение введенной функции при конкретных наборах переменных можно в 

привычной математической записи: 1( , ..., )nf x x . 

2. С помощью оператора присваивания <:>. При этом способе 

некоторому выражению, зависящему от одной или нескольких переменных, 

присваивается имя. Тогда для вычисления значений функции в конкретных 

точках или замены переменных алгебраическими выражениями может быть 

использована команда подстановки subs( 1x a , …, nx b , имя_функции). 

3. С помощью команды unapply(expr, x1, …, xn). Результатом работы 

команды является преобразование выражения expr в функциональный оператор. 

4. С помощью команды 

piecewise(cond_1, expr_1, …, cond_n, expr_n, expr), 

где cond_i ‒ условия, при котором функция определяется как expr_i; 

      expr – выражение (по умолчанию 0) для задания функции на оставшейся 

части области определения. 

Эта команда удобна для ввода кусочно-непрерывных функций. Если 

необходимо в таком формате определить некоторые пороговые функции (abs(), 

Heaviside(), signum() и др.), то можно использовать команду convert(). 

Например, для | |x  это выглядит следующим образом: 

>  

.
 

5. С помощью процедуры-функции 

f:=proc(x1, …, xn) 

                      expr 

end proc. 

При этом варианте задания получить значение введенной функции при 

конкретных наборах переменных можно, как и в п.1, в привычной 

математической записи: 1( , ..., )nf x x . 
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В Maple для некоторых математических операций существует по две 

команды: одна прямого, а другая – отложенного (инертного) выполнения. 

Имена функций для этих команд состоят из одинаковых букв, за исключением 

первой: команды прямого исполнения начинаются со строчной буквы, а 

команды отложенного исполнения – с прописной. После обращения к команде 

отложенного действия математические операции (предел, производная, 

интеграл и т. д.) выводятся на экран в виде стандартной аналитической записи, 

и вычисление в этом случае сразу не производится. Команда прямого 

исполнения выдает результат немедленно. 

Вычисление пределов 

Для вычисления предела lim ( )
x a

f x


 функции ( )y f x  в точке x a  

имеются две команды: прямого исполнения – limit(f(x), x a , options), 

отложенного – Limit(f(x), x a , options). 

Их обязательными аргументами являются аналитическое выражение f(x) 

для задания функции и значение точки a, в которой вычисляется предел. К 

числу необязательных параметров options относятся значения для поиска 

односторонних пределов (left – слева, right – справа), а также для указания типа 

переменной (real – действительная, complex – комплексная). 

Для исследования функции на непрерывность на заданном интервале 

(в том числе и бесконечном) можно использовать команду iscont(), которая 

возвращает логическое значение true в случае непрерывности и false – в 

противном случае. Если промежуток, на котором устанавливается 

непрерывность, является замкнутым отрезком, то к аргументам команды 

следует добавить необязательный параметр ´closed´. 

Для определения значений переменных, где нарушается непрерывность 

функции f(x), можно использовать команду discont(f(x), x). Также для этих 

целей может быть полезна команда singular(f(x)) для нахождения особых точек 

функции f(x).  
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Вычисление производных 

Для вычисления производной ( )f x  функции ( )y f x  в Maple имеются 

две команды: прямого исполнения – diff(f(x), x) и отложенного исполнения – 

Diff(f(x), x). Их обязательными аргументами являются аналитическое 

выражение f(x) для задания функции и переменная, по которой проводится 

дифференцирование. После выполнения дифференцирования полученное 

выражение можно упростить, используя, например, команды simplify, factor, 

combine или expand. 

Для вычисления производных старших порядков следует указать в 

параметрах команды x$n, где n – порядок производной. 

Команду diff можно применить и к функции нескольких переменных для 

нахождения частных производных. Для этого используется следующий ее 

формат: diff(f(x1, …, xk), x1$n1, …, xk$nk). 

Дифференциальный оператор 

Для определения дифференциального оператора для функции ( )y f x  

используется команда D(f), где f – функциональный оператор (см. способ 

задания функции под номером 1). Для производной порядка n можно 

использовать привычную математическую запись: ( )D ( )n f . 

Экстремум функции 

Для нахождения экстремума функции на заданном промежутке 

используются команды minimize(expr, ..x a b ) и maximize(expr, ..x a b ). По 

умолчанию, если не указан диапазон изменения переменной, рассматривается 

область определения функции, заданной с помощью выражения expr. Для 

получения точки минимума или максимума на отрезке добавляется параметр 

команды location. 
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Экстремальные значения функции нескольких переменных можно 

определить командой extrema(expr, {cond_1, …, cond_k}, {x1, …, xn}). Здесь 

expr – выражение, определяющее функцию n переменных x1, …, xn, второй 

аргумент – множество ограничений на переменные при нахождении условного 

экстремума. Если таких ограничений нет, вводится просто пара пустых 

фигурных скобок. Аналогично можно решить задачу на условный экстремум. 

Если добавить необязательный параметр ´s´ в аргументы команды, то 

выведутся точки экстремума в виде множества. 

Для численного решения задач оптимизации, линейного и нелинейного 

программирования в Maple 18 имеется специализированный пакет Optimization 

(см. при необходимости документацию Maple). 

Аналитическое интегрирование 

Для нахождения неопределенного интеграла ( )f x dx можно использовать 

две команды: прямого исполнения – int(f(x), x) и отложенного – Int(f(x), x). Их 

обязательными аргументами являются аналитическое выражение f(x) для 

задания подынтегральной функции и переменная интегрирования x. 

Для вычисления определенного интеграла ( )

b

a

f x dx  в командах int и Int 

добавляются пределы интегрирования, например, int(f(x), ..x a b ). 

Вводить команды для интегрирования функций можно также с помощью 

палитры Expressions. 

Поскольку Maple работает над полем комплексных чисел, интегралы 

находятся над функциями комплексного переменного. Если подынтегральная 

функция является аналитической функцией в односвязной области, 

содержащей точки a и b, то, как известно, интеграл не зависит от пути 

интегрирования. Поэтому при интегрировании функции действительной 
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переменной никаких проблем, кроме «неберущегося» интеграла, не должно 

возникнуть. 

В случае когда в области интегрирования есть особые точки и возникает 

необходимость применения теоремы о вычетах, для нахождения вычетов 

функции можно воспользоваться командой residue(). 

Несобственные интегралы 

Для исследования сходимости несобственного интеграла с бесконечными 

пределами интегрирования в параметрах команды int() необходимо указывать 

соответствующий диапазон изменения переменной интегрирования, например, 

x0..+infinity. Если интеграл не сходится к конечному значению, то Maple 

выдаст ответ ∞.  

Для исследования несобственных интегралов от неограниченных 

функций в команде интегрирования нужно добавить параметр continuous.  

В этом случае Maple будет игнорировать любые возможные разрывы 

подынтегральной функции в промежутке интегрирования. Если функция не 

определена хотя бы в одной точке отрезка интегрирования, то ответом будет 

undefined. 

Для нахождения приближенного числового значения интеграла можно, 

как было сказано выше, воспользоваться evalf-функцией:  

evalf(int(f(x), xa..b), n), 

где n – количество значащих цифр результата вычислений. 

Интегралы, зависящие от параметра 

Если требуется вычислить интеграл, зависящий от параметра a, то его 

значение может зависеть от знака этого параметра или каких-либо других 

ограничений. 

Очевидно, для получения явного аналитического результата вычислений 

следует сделать какие-либо предположения о значении a, т. е. наложить на него 
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ограничения в виде неравенств. Это можно сделать при помощи команды 

assume(ineq1), где ineq1 – простейшее неравенство относительно параметра. 

Если нужно использовать двойное неравенство, то дополнительные 

ограничения вводятся с помощью команды additionally(ineq2), где ineq2 – 

второе неравенство, ограничивающее значение параметра с другой стороны. 

После наложения ограничений на параметр Maple добавляет к его имени 

символ <~>. Например, параметр a, на который были наложены некоторые 

ограничения, в строке вывода будет иметь вид a~. 

Для уточнения введенных ограничений на параметр a можно 

использовать команду about(a). Например, требуется, чтобы переменная a 

удовлетворяла условию 1 5a  . Ввести эти ограничения, а затем убедиться в 

их справедливости можно следующим образом: 

>  

Originally a, renamed a~: 

  is assumed to be: RealRange(1,Open(5)). 

Основные методы интегрирования 

Использовать методы замены переменной и интегрирование по частям 

для нахождения интегралов можно с помощью команд пакета IntegrationTools, 

Change и Parts соответственно. Если в интеграле требуется сделать замену 

переменных th(x), то параметры команды замены переменных такие: 

Сhange(h(x) t, Int(f(x), x), t), где t  новая переменная. Команда интегрирования 

по частям ‒ Parts(Int(f(x), x), u(x)), где u(x) – функция, производную от которой 

предстоит вычислить по формуле интегрирования по частям. 

Пошаговое интегрирование 

В Maple имеется пакет Student, предназначенный для обучения 

математике. Он содержит набор команд, разбитых по темам и предназначенных 

для выполнения расчетов шаг за шагом так, чтобы была понятна 

последовательность действий, приводящих к результату. Их можно 
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использовать непосредственно, подключив нужные библиотеки, или вызвать из 

главного меню вкладку Tools → Tutors → … с различными графическими 

интерактивными приложениями для решения нужных задач. 

 

Интегральные преобразования 

 

В специализированном пакете inttrans содержатся команды, с помощью 

которых можно найти для заданной функции прямые и обратные 

преобразования Фурье, Лапласа, косинус- и синус-преобразования Фурье и 

некоторые другие.  

Численное интегрирование 

Численное интегрирование можно выполнить командой           

evalf(int(f(x), xa..b), n), где n – точность вычислений (число значащих цифр в 

результате). Кроме этого, можно использовать в команде int формат с 

плавающей точкой при вводе чисел. 

Для выбора аналитического или численного способа интегрирования в 

параметрах команды int предусмотрена также опция numeric со значениями 

false или true cоответственно. 

Создание процедур в Maple 

Как ранее упоминалось в разделе о способах задания функций, в Maple 

имеется возможность создавать собственные процедуры. Процедура начинается 

с заголовка, который состоит из имени (его пользователь определяет сам), 

оператора присваивания <:=> и служебного слова proc, после которого в 

круглых скобках через запятую указываются формальные параметры 

процедуры. 

Во избежание неполадок работы процедуры рекомендуется в строке ее 

заголовка описать переменные, которые будут использоваться только внутри 
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тела процедуры (локальные переменные). Для этого используется служебное 

слово local, после которого через запятую перечисляются переменные, 

наделенные этим качеством.  

После заголовка идет основное тело процедуры, состоящее из 

составленных пользователем команд, причем последняя команда будет 

выводить окончательный результат выполнения процедуры (или для этих целей 

может быть использована команда return). Заканчивается текст процедуры 

служебным словосочетанием end proc. 

Общий вид процедуры (стандартный синтаксис): 

name:=proc(var1, var2, …) local vloc1, vloc2, …; 

com1; 

com2; 

…………… 

сomn; 

end proc; 

Порядок обращения к процедуре такой: name(v1, v2,…), где v1, v2,… − 

значения формальных аргументов процедуры. 

Вычисление суммы и произведения членов последовательности 

Конечные и бесконечные суммы ( )
b

n a

f n


  вычисляются командами 

прямого исполнения sum() и отложенного исполнения  Sum(). Аргументы этих 

команд одинаковые: sum(f(n), na..b). Если требуется вычислить сумму 

бесконечного ряда, то в качестве верхнего предела индекса вводится infinity. 

Аналогичным образом вычисляются произведения ( )
b

n a

f n


 : командами 

product(f(n), na..b) – прямого и Product(P(n), na..b) − отложенного действий. 
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Разложение функции в степенной ряд 

Представление функции f(x) с помощью формулы Тейлора с остаточным 

членом в «О»-форме 
0

( ) (( ) )
n

k m
k

k

a x a O x a


    в окрестности точки а 

осуществляется командой series(f(x), xa, n) или taylor(f(x), xa, n). 

Команды series и taylor выдают результат, имеющий тип series. Для того 

чтобы иметь возможность дальнейшей работы с полученным разложением как 

с многочленом, его следует преобразовать в полином с помощью команды 

convert(%, polynom). Ниже приведен пример выполнения такой командой с 

контролем типа данных: 

 

 

 

 

. 

Функцию f(x1, …, xn) n переменных можно представить в виде многочлена 

Тейлора в окрестности точки (a1, …, an) порядка k с помощью команды 

mtaylor(f(x1, …, xn), [x1   a1, …, xn   an], k): 

>  

. 

Для работы с формальными степенными рядами предназначен пакет 

powseries. Для численной аппроксимации функций на интервале могут быть 

использованы команды из пакета numapprox. В частности, в нем есть команда 

laurent(), которую можно использовать для разложения функции в ряд Лорана. 
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Разложение функции в ряд Фурье 

 

В Maple нет специальной команды для разложения функции в ряд Фурье. 

Поэтому для решения такой задачи можно либо создать пользовательскую 

процедуру-функцию, либо искать коэффициенты напрямую в рабочем листе. 

Следует заметить, что ортогональные системы многочленов собраны в пакете 

orthopoly, содержащем команды . Например, Н() ‒ многочлены 

Эрмита, T() и U() – многочлены Чебышева, P() ‒ многочлены Лежандра (Якоби 

с дополнительными параметрами). 

1.6. Графические построения в Maple 

График явно заданной кривой 

Самый простой способ для построения графика действительной функции 

y   f(x), зависящей от одной переменной, ‒ использование команды         

plot(f(x), options), где options − параметры (необязательные) управления 

характеристиками изображения. 

Редактирование полученного чертежа можно осуществить с помощью 

контекстного меню, которое открывается щелчком правой кнопки мыши после 

наведения ее указателя на область графика. По умолчанию диапазон изменения 

независимой переменной от −10 до 10, а для тригонометрических функций −  

от 2π  до 2π . Для установки параметров управления изображением 

необходимо записать команду в более полном формате: ( ( ), )plot f x options , где 

options – параметры настройки. Если их не указывать, то будут использованы 

установки по умолчанию. 

Перечислим значения некоторых дополнительных опций команды plot: 

- axes   t – установка формы координатных осей (значения t могут быть 

normal – оси как две пересекающиеся прямые, boxed – график в рамке со 

шкалой,  frame – оси с центром в левом нижнем углу рисунка, none – без осей); 
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- axis[dir]   t – установка параметров цвета, градации и т. п. одной или 

обеих осей (если dir   1 – установки касаются оси Ox, если dir   2 – оси Oy, 

если параметр dir отсутствует – обеих осей); 

- color   t, или colour   t, – установка цвета графика (самое простое ‒ 

придать t значение цвета на английском языке, например, black – черный, 

yellow – желтый, red − красный и т. д.), можно также использовать мощные 

инструментальные средства пакета ColorTools по работе с цветом  

(см. справочные материалы Maple); 

- coords   polar – построить график в полярной системе координат  

(по умолчанию ‒ декартова), а если добавить еще параллельно опцию 

axescoordinates   polar, то на чертеже будут изображены радиальные лучи; 

- discont   t – указание на характер изображения графика функции в 

окрестности точек разрыва; например, для того чтобы убрать вертикальные 

асимптоты, которые строятся по умолчанию, t   true, а для выделения точек 

устранимого разрыва – t   [showremovable]; 

- font   [f, style, size] – установка типа шрифта для вывода текста (f задает 

название шрифтов – Times, Courier, Helvetica, Symbol, style задает стиль  

шрифта – bold, italic и др., size – размер шрифта в pt); 

- labels   [tx,ty] – надписи по осям координат (tx – по оси Оx, ty – по 

оси Оy); 

- legend   ′text′ – название введенного графика; 

- linestyle   n – тип линии графика (solid − непрерывная, dot − точечная, 

dash − пунктирная и т. д.), всего их 7, но вместо названия можно вводить 

соответствующий номер от 1 до 7 (n   1 – непрерывная, значение по 

умолчанию); 

- numpoints   n – минимальное количество генерируемых точек для 

построения графика (по умолчанию n   200), которое в случае необходимости 

увеличивается автоматически системой; 
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- scaling   t – установка масштаба рисунка (значение t   constrained – 

одинаковый масштаб по осям, unconstrained (по умолчанию) – график 

масштабируется по размерам окна); 

- style   t – вывод графика в виде линии (значение t   polygonoutline по 

умолчанию, line или polygon) или в виде точек (t   point); 

- symbol   t – фигура, которой помечают точки графика (asterisk, box, 

circle, cross, diamond, point и др.); 

- tickmarks   [m, n] – количество числовых меток по оси Оx и оси Оy 

соответственно; 

- thickness   n, где n   0, 1, 2, 3… – толщина линии (по умолчанию n 1); 

- title = ′text′, где text – заголовок рисунка (текст можно оставлять без 

кавычек, если он не содержит математических выражений). 

Для более детального изучения параметров команды plot() можно обратиться к 

справочной системе Maple. 

Графики нескольких явно заданных кривых 

Для построения нескольких графиков в одной системе координат можно 

использовать следующий формат команды plot и ее параметров:            

plot([y1(x), …, yk(x)], options). Ввод выражений для функций и соответствующие 

им значения параметров осуществляются как списки. 

График параметрически заданной кривой 

С помощью команды plot можно построить график параметрически 

заданной функции 
( ),

( ), [ , ],

x x t

y y t t a b




 
 используя следующий формат: 

plot([x(t), y(t),  t = a..b], options). 
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График неявно заданной кривой 

Для построения графика неявно заданной в прямоугольных координатах 

функции ( , ) 0F x y   может быть использована команда implicitplot из 

графического пакета plots. Напомним, что для вызова команды из 

специализированного пакета есть две формы. Короткая форма состоит из имени 

и аргументов команды: implicitplot(F(x, y)   0, x   a..b, y   c(x)..d(x), options). 

Ее применение возможно после подключения или всего пакета инструкцией 

with(plots), или только этой одной команды – with(plots, implicitplot). Более 

длинная форма записи не требует предварительного применения команды 

with(), а именно: plots[implicitplot](F(x, y)   0, x   a..b, y   c(x)..d(x), options). 

 

График явно заданной кривой в полярных координатах 

 

Выше упоминалась возможность построения графика функцииρ ρ(φ) , 

явно заданной полярными координатами, с помощью специальных значений 

параметров команды plot. Кроме описанного способа, график можно построить 

с использованием команды polarplot из пакета plots:                       

plots[polarplot](ρ(φ) , options). 

Диапазон изменения полярного угла по умолчанию принят от 0 до 2π. 

Подробное описание возможных значений дополнительных параметров дано в 

справочной системе с примерами их использования. 

График параметрически заданной кривой в полярных координатах 

Формат команды для построения графика функции 
ρ ρ( ),

φ φ( ), .. ,

t

t t a b




 
 

аналогичен команде построения параметрически заданной функции в 

декартовых координатах: plots[polarplot]([ρ( ), φ( ), ..t t t a b ], options). 
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График множества точек 

Для построения множества точек в пакете plots есть команда 

pointplot([[x1, y1], [x2, y2], …, [xk, yk]], options). По умолчанию точки не 

соединяются линией. Для использования дополнительных параметров 

управления качеством изображения в справочной системе есть полное описание 

значений опций, а в самой системе много интерактивных средств для этого 

(контекстное меню, специальные пакеты, например, CurveFitting). 

Для изображения множества точек числовой последовательности 

( )nx f n  от номера 1n  до номера 2n  можно использовать, например, 

следующую последовательность команд: pointplot     1 2, ( ) , ..seq n f n n n n . 

Множество точек можно изобразить также и с помощью встроенной 

универсальной команды plot([[x1, y1], [x2, y2], …, [xk, yk]], options). По умолчанию 

(без управляющих параметров options) построится ломаная с вершинами в 

перечисленных точках. Если ввести параметр style   point, то изобразятся 

точки, форму и размер которых можно определить либо через дополнительные 

параметры команды, либо с помощью контекстного меню после выведения 

рисунка на экран. 

Визуализация преобразования комплексной плоскости 

В пакете plots есть команда, позволяющая изображать множество точек, 

являющихся образами комплексной функции F(z) комплексной переменной z: 

conformal (F(z), z   a..b, options). Следующая группа команд выводит на экран 

соответственно прилежащий к координатным осям квадрат с вершиной в  

точке (2, 2) и его образ при отображении 2ω = 2z z : 

>  

>  
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Текстовые комментарии на изображении 

В пакете plots имеется команда textplot для вывода текстовых 

комментариев на рисунок: textplot([x, y, ′text′], options), где x, y – координаты 

точки, по которой центрируется надпись ′text′.  

Для управления изображением существует много параметров, подробно 

описанных в справочной системе. 

Несколько графических объектов на одном рисунке 

Часто бывает необходимо совместить на одном рисунке несколько 

графических объектов, полученных при помощи различных команд. Для этого 

результат действия команды присваивается некоторой переменной в инертной 

форме:  

> p:  plot(…): t:  textplot(…): imp:  implicitplot(…): pol:  polarplot(…): 

Затем для вывода графических объектов на экран необходимо выполнить 

команду display(…) из пакета plots: 

>with(plots): display([p, t, imp, pol], options). 

Двумерная область, заданная неравенствами 

Если необходимо построить двумерную область, заданную системой 

неравенств 1 1 2 2( , ) , ( , ) , ..., ( , )n nf x y c f x y c f x y c   , то для этого можно 

использовать команду inequal из пакета plots. В команде                    
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inequal({f1(x, y) > c1, …, fn(x, y) > cn}, x   a..b, y   c..d, options) в фигурных 

скобках указывается система неравенств, определяющих область, затем 

диапазон изменения переменных и дополнительные параметры. С их помощью 

можно регулировать цвет открытых и закрытых границ, внешней и внутренней 

областей, а также толщину линий границ. Например:  

- optionsfeasible   [color   red] – установка цвета внутренней области; 

- optionsexcluded   [color   yellow] – установка цвета внешней области; 

- optionsopen   [color   blue, thickness   2] – установка цвета и толщины 

линии открытой границы; 

- optionsclosed   [color   green, thickness   3] – установка цвета и 

толщины линии закрытой границы. 

График заданной явно поверхности 

График функции ( , )z f x y  можно изобразить, используя команду 

plot3d(f(x, y), x   a..b, y   c..d, options). Параметры этой команды частично 

совпадают с параметрами команды plot. К часто используемым параметрам 

команды plot3d относится light   [angl1, angl2, c1, c2, c3] – задание подсветки 

поверхности, создаваемой источником света из точки со сферическими 

координатами (angl1, angl2). Цвет определяется долями красного (c1), зеленого 

(c2) и синего (c3) цветов, которые находятся в интервале [0, 1]. Используя 

контекстное меню, можно регулировать стиль изображения, качество и тон 

заполнителя, линии уровня и т. д. 

Графики нескольких явно заданных поверхностей 

Для построения нескольких графиков в одной системе координат можно 

использовать следующий формат команды plot3d и ее параметров: 

plot3d([z1(x, y), …, zk(x, y)], x   a..b, y   c..d, options). 

Ввод выражений для функций и значения параметров осуществляется как 

список: 
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>  

  

График параметрически заданной поверхности 

Если требуется построить поверхность, заданную параметрически 

уравнениями x   x(u, v), y   y(u, v), z   z(u, v), то эти функции перечисляются в 

квадратных скобках в команде: plot3d([x(u, v), y(u, v), z(u, v)], u   a..b, v   c..d). 

График неявно заданной поверхности 

Трехмерный график поверхности, заданной неявно уравнением 

( , , ) 0F x y z  , строится с помощью команды implicitplot3d пакета plots: 

implicitplot3d(F(x, y, z)   0, x   a..b, y   c..d, z   e..f), где указывается уравнение 

поверхности ( , , ) 0F x y z   и размеры рисунка по координатным осям. 

График пространственной кривой 

В пакете plots имеется команда spacecurve для построения 

пространственной кривой, заданной параметрически уравнениями 

( ), ( ), ( )x x t y y t z z t   . Ее ввод в компактном формате: 

plots[spacecurve]([x(t), y(t), z(t)], t   a..b, options). 
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Анимация 

Maple позволяет выводить на экран движущиеся изображения с помощью 

команд animate (для двумерного случая) и animate3d (для трехмерного случая) 

из пакета plots. Имеется в виду следующее: если некоторая функция зависит от 

дополнительного параметра (например, времени), эти команды позволяют 

сформировать совокупность кадров в диапазоне его изменения, а затем 

последовательно их отобразить друг за другом с определенной частотой. Для 

проигрывания результата нужно выделить график, который появится после 

выполнения команды, и воспользоваться кнопками контекстной панели 

анимации или правой кнопкой мыши для вызова контекстного меню. Функции 

кнопок можно уточнить по всплывающим подсказкам, которые появляются при 

наведении на них указателя мыши. 

Наиболее простой вариант создания объекта двумерной анимации – 

использование команды со следующим синтаксисом: 

animate(f(x, t), x=x1..x2, t   t1..t2, options), 

где f(x, t) – аналитическое выражение, явно задающее функцию y=f(x,t), которая 

зависит от переменной x и параметра t; 

x   x1..x2 – диапазон изменения переменной x; 

t   t1..t2 – диапазон изменения параметра t; 

options – дополнительные опции команды. 

Рассмотрим в качестве примера построение анимационного изображения 

графика функции 
1

1
y

tx



 в зависимости от коэффициента при x: 

>  
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В области вывода появляется график функции при t   1 (первое значение 

параметра из заданного промежутка), который нужно выделить с помощью 

мыши для вызова контекстной панели средств анимации. По умолчанию будет 

показано динамическое изображение шестнадцати кадров. Их число можно 

изменить с помощью опции frames. 

Можно создавать анимацию также для параметрически заданной кривой, 

для кривой в полярной системе координат, для множества точек, 

изменяющихся по определенному правилу. 

В пространстве анимацию можно создать как с использованием команды 

animate() со специальным синтаксисом, так и с помощью animate3d(): 

; 

. 

Анимационные команды могут одновременно отображать изменение 

нескольких функций. Все они при этом должны зависеть от одних и тех же 

независимых аргументов и одного параметра. 

Проследить в динамике за построением графика кривой можно также, 

используя команду animatecurve() этого же пакета: 

.
 

 

1.7. Работа с матрицами 

 

Для решения задач линейной (векторной и матричной) алгебры в Maple 

имеется специализированный пакет LinearAlgebra, который загружается 

командой with(LinearAlgebra)[;\:]. Если воспользоваться фиксатором <;>, то 

более ста команд пакета будут выведены на экран в алфавитном порядке. Их 

назначение интуитивно понятно, так как каждое имя команды представляет 

собой слово (словосочетание) или их сокращение на английском языке. Ниже 

рассматриваются некоторые команды этого пакета.  
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Способы задания векторов 

 

Для определения вектора в Maple можно использовать команду       

Vector[column\row]([x1, x2, …, xn], options), где в квадратных скобках через 

запятую указываются координаты вектора: 

>  

. 

Эта команда представляет собой одну из форм функции-конструктора 

Vector(…) c аргументом, непосредственно задающим вектор с помощью списка. 

По умолчанию ‒ это матрица-столбец. Для задания матрицы-строки можно 

добавить необязательный параметр row: 

>  

. 

Существует также совсем краткая форма в виде непосредственного ввода 

компонент вектора в угловых скобках: 

>  

. 

Полное описание возможностей конструктора векторов можно найти в 

справочной системе с большим количеством примеров разных случаев. Ниже в 

настоящем пособии будут также описаны дополнительные особенности для 

создания и работы со специальными матрицами, которые применимы и к 

векторам.  

Координату уже определенного вектора x можно получить, записав x[i], 

где i  номер координаты. Например, вторую координату вектора x можно 

вывести так: 

>  

. 
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Операции над векторами 

 

Основные операции над векторами и команды для их ввода в Maple 

приведены в табл. 5. 

Таблица 5 

Простейшие операции над векторами 

Операция Матема-

тическая 

запись 

Maple-функция из пакета 

LinearAlgebra Встроенная команда 

Сложение a b  Add(a, b), VectorAdd(a, b) a b  

Вычитание a b  Add(a, b, 1, −1), 

VectorAdd(a, b, 1, −1) 

a b  

Умножение 

на число 

сa  ScalarMultiply(a, c) 

VectorScalarMultiply(a, c) 

,с a с a   

Линейная 

комбинация 

1 2с a с b  Add(a, b, с1, с2), 

VectorAdd(a, b, с1, с2) 

1 2 1 2* * ,с a c b c a c b   

 

Скалярное 

умножение 

 ,a b  DotProduct(a, b) .a b  

Векторное 

умножение 

,a b 
   CrossProduct(a, b) a b  

 

Продемонстрируем получение результатов операций из табл. 5: 

>  

. 

>  

. 

>  

. 

>  

. 

 



47 

 

>  

. 

>  

. 

>  

. 

Кавычки используются в левых частях равенств для подавления вывода 

результата с целью лишь символьной записи операции. 

 

Норма вектора 

 

Норму вектора 1( , ..., )na x x , которая равна 

 
1/

1 ... , 1
n

n n
na x x n     , можно вычислить с помощью команды 

VectorNorm(a, n) (или Norm(a, n)): 

>  

. 

>  

. 

>  

. 

>  

. 

По умолчанию n   infinity. При n   2 (или n   Euclidean), как видно из 

примера, получаем евклидову норму, что для геометрических векторов 

означает их длину. 

Для нормирования вектора X можно применить функцию normalize(X, n), 

в результате которой будет получен орт 0

X
X

X
  вектора X: 

>  
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. 

 

Угол между двумя векторами 

 

Для вычисления угла между векторами a и b используется значение его 

косинуса при нахождении скалярного произведения. Достигается это с 

помощью команды VectorAngle(a, b, options): 

>  

 

>  

 

>  

 

>  

. 
 

Нахождение базиса системы векторов 

 

Если имеется система 1 2{ , , ..., }na a a  n векторов, то с помощью команды 

Basis([a1, a2, …, an]) можно найти ее базис, а функция GramSchmidt([a1, a2, …, an]) 

ее ортогонализирует по алгоритму Грамма – Шмидта. Если исходная система 

не является линейно независимой, то количество векторов в результате станет 

меньшим. Для выполнения нормализации необходимо ввести в аргументы 

команды параметр normalized: 

>  
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. 

Для контроля можно найти попарно скалярное произведение полученых 

векторов и их длины: 

>  

 

>  

. 

 

Способы задания матрицы 

 

Для определения матрицы в  Maple можно использовать 

команду Matrix(m, n, [[a11, a12, …, a1n], [a21, a22, …, a2n],…, [am1, am2, …, amn]]), 

где m  количество строк, n – количество столбцов в матрице. Эти числа 

задавать необязательно, а достаточно перечислить элементы матрицы 

построчно в квадратных скобках через запятую: 

>  

. 

С помощью дополнительных команд в Maple можно генерировать 

матрицы специального вида. В частности, диагональную матрицу и ее различные 

обобщения можно получить командой DiagonalMatrix(L, m, n, options), где  

L – список диагональных элементов или матричных блоков, m и n – размеры 

результирующей матрицы: 

>  

 

>  
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>  

 

>  

 

>  

. 

Генерировать матрицу можно и с помощью функции y   f(i, j) от 

переменных i,  j – индексов элементов матрицы Matrix(m, n, f): 

>  

 

>  

. 

Размер матрицы А, количество ее строк и столбцов можно определить 

соответственно с помощью команд Dimension(A), RowDimension(A) и 

ColumnDimension(A). 

 

Операции над матрицами 

Основные операции над матрицами и команды для их ввода в Maple 

приведены в табл. 6. 
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Таблица 6 

Простейшие операции над матрицами 

Операция 

Матема-

тическая 

запись 

Maple-функция 

из пакета LinearAlgebra 

Встроенная 

команда 

Сложение 
A+B 

Add(A, B), 

MatrixAdd(A, B) 
A+B 

Вычитание 
A−B 

Add(A, B, 1, −1), 

MatrixAdd(A, B, 1, −1) 
A−B 

Умножение на 

число 
сA  

ScalarMultiply(A, c), 

MatrixScalarMultiply(A, c) 

,с A

с A




 

Линейная 

комбинация 
1 2с A с B  

Add(A, B, с1, с2), 

MatrixAdd(A, B, с1, с2) 

1 2

1 2

* * ,с A c B

c A c B



  
 

Умножение AB 
Multiply(A, B) 

MatrixMatrixMultiply(A, B) 
.A B  

Возведение  

в степень 

nA  MatrixPower(A, n) A^n 

Обратная матрица 
1A  MatrixInverse(A) 

^ ( 1),

1 /

A

A


 

Транспонирование TA  Transpose(A)  

 

В качестве второго аргумента в командах, вычисляющих произведение, 

можно указывать и вектор, например: 

>  

 

 

>  
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>  

 

>  

 

>  

 

>  

. 

 

Определитель, минор, ранг и след матрицы 

 

Определитель квадратной матрицы А можно вычислить с помощью 

команды Determinant(A). Функция Minor(A, i, j) возвращает значение минора 

элемента ija  этой матрицы. С помощью специальных параметров последней 

команды можно не только вычислить миноры элементов квадратной матрицы, 

но и выделить различные подматрицы из исходной. 

Для определения ранга матрицы можно использовать команду Rank(A). 

След матрицы, равный сумме ее диагональных элементов, вычисляется 

командой Trace(A). 

Приведем примеры решения некоторых типичных задач с помощью 

команд специализированного пакета линейной алгебры: 

>  

 

>  

 

>  

. 
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Собственные значения и собственные векторы матрицы 

 

Получить характеристический многочлен матрицы А относительно 

переменной x можно с помощью команды CharacteristicPolynomial(A, x). Для 

нахождения собственных значений матрицы А используется команда 

Eigenvalues(A). Для одновременного нахождения собственных значений и 

собственных векторов матрицы А ‒ команда Eigenvectors(A): 

>  

 

 

>  

. 

 

Канонические и специальные виды матрицы 

 

Выяснить, являются ли матрицы A и B подобными, можно с помощью 

команды IsSimilar(A, B). Ортогональность, унитарность, типы эрмитовых 

матриц можно определить соответственно с помощью команд IsUnitary(A), 

IsOrthogonal(A) и IsDefinite(A, q   t), где t может принимать одно из следующих 

значений: 'positive_definite', 'positive_semidefinite', 'negative_definite', 

'negative_semidefinite' или 'indefinite'. 

Привести матрицу А к нормальной форме Жордана можно с помощью 

команды JordanForm(A). Верхнюю треугольную матрицу, эквивалентную 

матрице А, вернет функция GaussianElimination(A). Характеристическую 
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матрицу относительно переменной x можно построить, используя команду 

CharacteristicMatrix(A, x). Например: 

>  

 

>  

 

>  

. 

Кроме этого, из матриц можно конструировать другие с помощью 

операций удаления и добавления строк и столбцов (см. документацию Maple по 

специализированному пакету LinearAlgebra). 

 

Системы линейных уравнений и матричные уравнения 

 

Решение системы линейных уравнений  

11 1 12 2 1 1

1 2 2

... ,

...............................................

...

n n

m m m mn n m

a x a x a x b

a x a x a x b

   


    

 

(или в матричной форме Ax b ) может быть получено, например, следующими 

способами.  

Способ 1. С помощью стандартной команда solve(), вводя в развернутом 

виде уравнения системы в качестве аргументов. 

Например, решим систему уравнений с тремя неизвестными: 

2 3 5 1,

4 6 2 2,

2 3 11 1.

x y z

x y z

x y z

  


  
   

 



55 

 

Для этого введем систему, назначив ей имя slau, и используем ее в 

качестве аргумента команды solve: 

>  

 

>  

. 

В результате видим, что заданная система имеет бесконечное множество 

решений. Поскольку этому множеству присвоено имя s, то для нахождения 

частного решения системы можно использовать подстановку: 

>  

. 

Способ 2. Команда LinearSolve(A, b) из пакета LinearAlgebra находит 

решение уравнения Ax b  введением аргументов А – матрица ‒ и b – вектор. 

Maple-решение slau в этом случае будет выглядеть следующим образом: 

>  

. 

Здесь _t02 – произвольная постоянная. В этом случае решение получено в 

виде вектор-столбца: 

>  

. 

Можно также ограничиться вводом одной расширенной матрицы 

системы, т. е. матрицей, полученной приписыванием к матрице А системы 

столбца b  ее свободных членов. Если задать сразу расширенную матрицу 

системы, то результат может быть получен также с использованием команды 

LinearSolve: 

>  
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. 

Для решения систем линейных уравнений разными методами у команды 

LinearSolve есть целый арсенал дополнительных параметров, о которых можно 

узнать в справочной системе. 

 

Ядро матрицы 

 

Ядро матрицы А – это множество векторов, произведение матрицы А на 

которые равно нулевому вектору. Они представляют собой решение 

однородной системы линейных уравнений с матрицей A. Найти базис 

пространства таких векторов можно с помощью команды NullSpace(A): 

>  

 

>  

. 

 

1.8. Решение дифференциальных уравнений и их систем 

Для решения обыкновенных дифференциальных уравнений (ОДУ) в 

Maple имеется команда dsolve(), которая пытается найти общее решение в 

аналитическом виде, и пакет DEtools с возможностями численного решения 

задачи Коши и мощной графикой. Кроме того, Maple позволяет эффективно 

получить приближенное аналитическое решение с помощью подходящих 

рядов. Для решения дифференциальных уравнений в частных производных 

можно обратиться к пакету PDEtools. 
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Аналитическое решение ОДУ и их систем 

 

Для нахождения в Maple общего решения обыкновенного 

дифференциального уравнения (ОДУ) в символьном виде можно применить 

команду dsolve() в следующем формате: dsolve(DEq, options), где DEq – 

заданное уравнение, options – дополнительные (необязательные) параметры. 

Они могут указывать метод решения задачи. По умолчанию ищется 

аналитическое решение, хотя для этих целей может быть использован аргумент 

команды type   exact. При вводе дифференциального уравнения для 

обозначения производной искомой функции ( )y x  применяется команда diff: 

>  

. 

Следует обратить внимание на то, что искомая функция вводится со 

своим независимым аргументом. 

Общее решение ОДУ зависит от произвольных постоянных, количество 

которых равно порядку дифференциального уравнения. В  Maple такие 

константы обозначаются как _С1, _С2 и т. д. 

Общее решение неоднородного линейного дифференциального уравнения 

выводится в виде суммы общего решения соответствующего однородного 

дифференциального уравнения (с произвольными постоянными) и одного из 

его частных решений (без произвольных постоянных): 

>  

 

. 

Команда dsolve() выдает решение дифференциального уравнения в 

невычисляемом формате. Для дальнейшей работы с решением можно выделить 

правую часть полученного равенства командой rhs(%). 
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Например, для построения графика полученной функции при _C1   1 и 

_C2   0 можно ввести следующую последовательность команд: 

>  

 

>  

 

>  

  

Команда dsolve() предоставляет возможность найти фундаментальную 

систему решений (базисные функции) ОДУ. Для этого в параметрах команды 

dsolve() следует указать параметр output   basis: 

>  

 

. 

Команда dsolve() может найти решение задачи Коши, если помимо 

дифференциального уравнения задать начальные условия для искомой 

функции. Для обозначения производных в начальных условиях используется 

дифференциальный оператор D. Например, условие (1) 2y   следует записать в 

виде . 

Команда dsolve() может найти решение системы обыкновенных 

дифференциальных уравнений, если использовать следующий ее формат: 

dsolve({de1, de2, …, den}, {x(t), …, y(t)}), где {de1, de2, …, den}  множество 

уравнений, входящих в заданную систему, x(t), …, y(t)  неизвестные функции. 
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Найдем решение системы дифференциальных уравнений относительно 

двух неизвестных функций: 

>  

 

>  

. 

Найдены две функции x(t) и y(t), которые зависят от двух произвольных 

постоянных _С1 и _С2. 

Заметим, что переменные x и y заданной системы необходимо вводить 

как функции независимого аргумента t, т. е. в виде x(t) и y(t) соответственно. 

Если этого не сделать, Maple выдаст ошибку: 

>  

 

>  

Error, (in dsolve) ambiguous input: the variables {x, y} and 

the functions {x(t), y(t)} cannot both appear in the system. 

 

Приближенное решение ОДУ и их систем 

 

В случае когда аналитическое решение дифференциального уравнения не 

может быть найдено или слишком громоздко, можно использовать разложение 

неизвестной функции в степенной ряд или численное приближение решения. 

Чтобы найти приближенное решение дифференциального уравнения в 

виде степенного ряда, в команде dsolve() следует после переменных указать 

параметр type   series (или просто series). Для того чтобы указать порядок n 

разложения, следует перед командой dsolve() вставить его определение с 

помощью команды Order:  n. По умолчанию значение системной переменной 

Order равно 6. 
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Если ищем общее решение дифференциального уравнения в виде 

степенного ряда, то коэффициенты при степенях х найденного разложения 

будут содержать неизвестные значения y(0) функции в нуле и ее производных 

D(y)(0), (D(2))(y)(0) и т. д. Для выделения частного решения следует задать 

начальные условия y(0)   у0, D(y)(0)   у1, D(2)(y)(0)   у2 и т. д., причем 

количество этих начальных условий должно совпадать с порядком 

соответствующего дифференциального уравнения. 

Разложение в степенной ряд имеет тип series, поэтому, как говорилось 

ранее, для дальнейшей работы его следует преобразовать в полином с помощью 

команды convert(%, polynom), а затем выделить правую часть полученного 

выражения командой rhs(%). 

Найдем точное и приближенное в виде степенного ряда до 4-го порядка 

решения ОДУ cosy y x x   . Сравним их при начальных условиях 

(0) 1, (0) 1, (0) 2y y y    , построив соответствующие графики в одной системе 

координат. Используем следующий набор команд Maple: 

>  

 

 

 

>  

 

 

>
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>  

  

Графический результат позволяет убедиться в том, что наилучшее 

приближение точного решения степенным рядом достигается примерно на 

интервале  1 < x < 1. 

 

Численное решение дифференциальных уравнений 

 

Для того чтобы найти численное решение дифференциального уравнения 

(задачи Коши или краевой задачи) в команде dsolve() следует указать  

параметр type   numeric (или просто numeric). Тогда команда  

решения дифференциального уравнения будет иметь вид  

dsolve(de, var, type   numeric, options), где de – уравнениe, var – неизвестная 

функция, options – параметры, позволяющие указать метод численного 

интегрирования дифференциального уравнения. В Maple реализованы, 

например, такие методы: 

- method   rkf45  метод Рунге ‒ Кутты ‒ Фельберга 4‒5-го порядка 

(установлен по умолчанию); 

- method   dverk78 – метод Рунге ‒ Кутты 7‒8-го порядка; 

- method   classical – классический метод Рунге ‒ Кутты 3-го порядка;  

- method   gear ‒ одношаговый метод Гира; 

- method   mgear – многошаговый метод Гира. 
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График численного решения дифференциального уравнения можно 

построить с помощью команды odeplot(dsn, [x, y(x)], x   x1..x2), где в качестве 

выражения используется результат команды 

dsn:=dsolve({de, cond}, y(x), numeric) численного решения, после нее в 

квадратных скобках указывают переменную и неизвестную функцию [x, y(x)], а 

также интервал x   x1..x2 для построения графика. Заметим, что требуется 

подключение пакета plots для ее выполнения. 

Найдем численное решение уравнения 2y xy    при условии (0) 1y   и 

сравним с точным, построив графики: 

>  

 

>  

>  

>  

  

Видим, что найденные решения практически совпадают. 

Формат команды dsolve() для численного решения системы ОДУ 

отличается незначительно: dsolve({sde, cond}, {vars}, type   numeric, options), 

где sde – последовательность уравнений системы, cond – начальные условия, 

vars – последовательность неизвестных функций, options – параметры, 

позволяющие указать метод численного интегрирования дифференциальных 

уравнений. 
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Найдем решение системы ( ) ( )cos( ) ( ), ( ) sin( )x t y t t x t y t t t      ОДУ с 

начальными условиями (0) 1, (0) 2x y   с помощью численного метода и 

построим графики найденных функций в одной системе координат: 

>  

>  

   

Для численного решения задачи Коши, построения графиков решения и 

фазовых портретов в Maple имеется специальный пакет DEtools.  

Команда DEplot() из пакета DEtools строит численными методами 

графики решения или фазовые портреты. Эта команда аналогична команде 

odeplot(), но более функциональна: она сама производит численное решение 

дифференциального уравнения. Основные параметры DEplot() похожи на 

параметры odeplot(): DEplot(sde, vars, range, x   х1..х2, …, y   у1..у2, cond, 

options), где sde  система дифференциальных уравнений (или одно уравнение), 

vars – последовательность неизвестных функций (или одна функция), range – 

диапазон изменения независимой переменной, cond – начальные условия,  

x   х1..х2 и y   у1..у2 – диапазоны изменения функций, options – 

дополнительные (необязательные) параметры. 

Наиболее востребованные параметры: 

- linecolor ‒ цвет линии; 
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- scene   [x, y] ‒ определение зависимости для вывода графика; 

- iterations   n ‒ число итераций, необходимое для повышения точности 

вычислений (по умолчанию n   1); 

- stepsize   number ‒ число, равное расстоянию между точками на 

графике (по умолчанию number   (x2  x1)/48); 

- obsrange   true/false  указатель прерывания вычислений в случае 

выхода графика решения за установленный диапазон (по умолчанию имеет 

значение true); 

- различные параметры для анимации (см. справочные материалы о 

команде). 

С помощью команды DEplot() можно построить фазовый портрет для 

системы двух дифференциальных уравнений 1 2( ) ( , , ), ( ) ( , , )x t f t x y y t f t x y   , 

если в параметрах данной команды указать значение scene   [x, y].  

Если система дифференциальных уравнений является автономной, то на 

фазовом портрете будет построено поле направлений в виде стрелок. Размер 

стрелок регулируется параметром arrows. 

Для того чтобы нарисовать весь фазовый портрет, необходимо для 

каждой фазовой траектории указывать начальные условия. Например, для 

системы двух дифференциальных уравнений 1-го порядка несколько начальных 

условий в команде DEplot() указываются после задания диапазона изменения 

независимой переменной t: [[x(t0)   x0, y(t0)   y0], [x(t0)   x1, y(t0)   y1], …]. 

Начальные условия можно задавать в более компактной форме [t0, x0, y0], 

где t0  точка, в которой задаются начальные условия, x0 и y0  значения 

искомых функций в точке t0. 

Фазовый портрет системы двух дифференциальных уравнений 1-го 

порядка можно также построить с помощью команды phaseportrait(sde, [x, y], 

x1..x2, [[cond]]), где sde  система двух дифференциальных уравнений  

1-го порядка, [x, y]  имена искомых функций, x1..x2  интервал, на котором 
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следует построить фазовый портрет, а в скобках указываются начальные 

условия. 

Напомним, что рассмотренные команды находятся в пакете DEtools, 

который должен быть предварительно загружен. 

Приведем пример решения аналогичной задачи с использованием 

команды phaseportrait() (систему и начальные данные несложно увидеть в 

приведенном ниже тексте программы): 

 

 

  

Наконец, приведем пример системы с тремя неизвестными функциями 

( ), ( ), ( )x t y t z t , отражающий зависимость z от x (параметр scene команды 

phaseportrait): 

>  
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2. Упражнения с комментариями к их выполнению 

Для выполнения упражнений откройте установленную на компьютере 

программу Maple 18. Создайте новый файл в режиме Worksheet.  

Потренируйтесь вызывать справочную систему разными способами на 

основании приведенного выше материала. 

Найдите учебники, используя вкладку Help главного меню. 

Изучите команды основного меню и возможности палитр. 

Сохраните файл под именем ФамилияУпражнения.  

Все приведенные ниже тренировочные задания выполняйте в созданном 

файле ФамилияУпражнения. Начинайте с ввода порядкового номера задачи в 

текстовом режиме или через знак <#> (комментарий). Не забывайте 

прописывать команду restart; перед каждой новой задачей.  

1. Сравните результаты работы системы по извлечению кубического 

корня (одного действительного значения) из целого числа 27, записанного в 

разных форматах. Найдите арифметический квадратный корень из числа π . 

Округлите второй результат до трех верных цифр. 

Пример решения 

Наберите по очереди команды: 

> <enter> 

> 3 27.0 <enter> 

1/327.0 <enter> 

> <enter> 

> <enter> 

> <enter>. 

 

2. Вычислите значение выражения  

(7 6,35) :6,5 9,9
.

5 169
1,2 :36 1,2 :0,25 1 :

16 24

 

 
  

 
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Пример решения 

Введите следующий набор символов: 

((7−6.35)/6.5→+9.9)/(1.2/36→+1.2/0.25→−1−5/16→)/169/24→→→<enter>. Если 

набор осуществлен верно, то должен получиться ответ 20 с десятью цифрами в 

записи числа. Примените команду evalf, чтобы в ответе было только две цифры. 

3. Упростите выражение 4 2 3 4 2 3   с помощью разных способов 

выполнения и вывода результата. 

Пример решения 

Ввод с клавиатуры в синтаксисе Maple: 

>  

 

>  

 

>  

. 

4. Найдите точные и приближенные значения функций: 2log 3, cos , ctg7
4


. 

Пример решения 

>  

 

>  

 

>  

 

>  
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>  

 

>  

. 

5. Найдите значение комплексного выражения z=
101 2

2 3

i
i

i




  
в 

алгебраической форме.  

Пример решения 

Наберите в командной строке 

z:=(1+2*I)/2-3*I<→>+I^10<enter>. 

В результате должно получиться: 

>  

.
 

6. Найдите модуль и аргумент числа 3z i   и значение 
20z . 

Пример решения 

>  

>  

 

>  

 

>  

 

>  

. 

7. Найдите все значения 6 1  и изобразите соответствующие им точки на 

комплексной плоскости. 

 



69 

 

Пример решения 

>  

>  

 

>  

>  

 

 

 

 

 

 

 

>  

  

Для нахождения всех значений корня была задана известная из 

комплексного анализа формула как функция, зависящая от номера k корня по 

отношению к его главному значению (при k   0). Затем с помощью простого 

цикла было найдено семь значений корня для того, чтобы показать, что седьмое 

значение совпадает с главным. Чтобы построить замкнутый правильный 

шестиугольник, вершины которого соответствуют найденным шести 
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различным значениям 6 1  комплексной плоскости, была использована 

команда из графического пакета plots. 

8. Найдите значения логарифма Ln( 1 )i  . 

Пример решения 

Для нахождения главного значения логарифма можно применить 

встроенную математическую команду ln и применить к результату evalc-

процедуру: 

>  

 

.
 

Можно получить запись результата также в виде равенства: 

>  

 

.
 

Для нахождения всех значений натурального логарифма комплексного 

числа можно определить соответствующий функциональный оператор, 

например, следующим образом: 

>  

. 

Тогда для нахождения частных значений может быть использована 

привычная математическая запись. Ниже приведена общая формула для 

нахождения Lni , а также его значения в этой точке при k   2: 

>  

.
 

>  

. 
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9. Упростите 2x . 

Пример решения 

Получение общей формулы: 

>  

. 

В ответе csgn(x) системы получена пороговая функция (signum – знак), 

принимающая значение 1 при положительных значениях аргумента, −1 – при 

отрицательных, 0 – в нуле. 

Для ограничения области изменения аргумента можно ввести 

дополнительный параметр через опцию assume: 

>  

. 

10. Упростите выражение 33 3 10 6 3   . 

Пример решения 

Сравните действия двух команд: 

>  

  

>  

. 

11. Решите уравнение 
2 5 6 0x x   . 

Пример решения 

На простом примере показано ниже, что в случае, когда уравнение имеет 

несколько решений, они организуются как одномерный массив exprseq 

(последовательность выражений) данных. Доступ к элементам такого типа 

осуществляется командой Имя_массива[номер_элемента]. Первому элементу 

соответствует номер 1, последнему ‒ или номер последнего по порядку 
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элемента, или ‒1. Для определения имени массива используется оператор <:> 

присваивания. 

>  

 

>  

 

. 

Примечание 

Во время работы часто необходимо знать тип данных. Тип 

контролируемой переменной s можно определить командой whattype(s). 

12. Найдите точное и приближенное решение уравнения 3 ln 2x  . 

Пример решения 

>  

>  

> . 

Выполните команды, сравните полученные результаты, округлите ответ 

до сотых. 

13. Решите уравнение sin 1x    аналитически и графически.  

Пример решения 

Получение главного значения корня уравнения: 

> . 

Для вывода общей формулы всех решений необходимо добавить опцию 

allsolutions в аргументы команды solve:  

>  

. 

Символ _Z1~ обозначает константу целого типа, поэтому общее решение 

данного уравнения имеет вид: 2
2

x k


    , где k  ‒ целое число. 
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Для графического решения можно использовать встроенную команду 

plot: 

>  

 

или 

>  

 

  
Первый формат ввода позволяет определить корни уравнения как 

абсциссы точек пересечения двух введенных графиков, соответствующих левой 

и правой частям заданного уравнения. Второй формат позволяет их увидеть при 

пересечении графика введенной функции с осью абсцисс, т. е. непосредственно 

на самой оси. 

14. Найдите x y , где ( , )x y  ‒ решение системы уравнений 

 
2,

5 6 2.

ax y

x ay

 


 
 

Пример решения 

Во втором аргументе команды solve необходимо указать переменные, 

относительно которых ведется поиск решения системы. Для доступа к 

элементам можно присвоить имя результату работы команды solve. 

>  

 

>  
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.
 

15. Решите в целых числах уравнение 2 5 7x y  . 

Пример решения 

>  

. 

Подставляя вместо системной переменной _Z1 любые целые значения, 

можем получать частные решения: 

>  

 

 

 

 

 

. 

16. Решите графически систему неравенств  

1,

2 3,

5.

x y

x y

y x

 


 
  

 

Пример решения 

>

 

17. Постройте график функции 2sin cosy x x  . 
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Пример решения 

Для выполнения упражнения наберите в командной строке 

. Наведите курсор на область графика и, щелкнув 

правой кнопкой мыши, вызовите контекстное меню. Измените цвет линии, 

толщину, масштаб и т. д. 

18. Постройте в одной системе координат графики функции 32cosy x и 

ее производной. Подпишите полученные кривые с помощью параметра legend, 

введя формулы для описания уравнений кривых соответствующего цвета. 

Пример решения 

Задание можно выполнить с помощью следующей команды: 

.
 

19. Исследуйте функцию 
2 1

x
y

x



 на непрерывность, найдите предел в 

точках разрыва и на бесконечности, постройте график с вертикальными 

асимптотами и без них. 

Пример решения 

Для выполнения упражнения можно воспользоваться следующими 

командами: discont(f(x), x) или singular(f(x)), limit(f(x), x a , options) с 

соответствующими опциями и plot(f(x), options). 

20. Найдите производную функции 3 lny x x . Постройте в одной системе 

координат графики функции и ее касательной в точке с абсциссой, равной 5. 

Пример решения 

Для нахождения производной функции ( )y f x  можно воспользоваться 

командой ( ( ), )diff f x x  или дифференциальным оператором D( )( )f x . 

Уравнение касательной к графику функции ( )y f x  в точке 0 0( , ( ))x f x  имеет 

вид 0 0 0( ) ( )( )y f x f x x x   . Для построения графиков в одной системе 

координат удобна в использовании встроенная команда 1 2([ ( ), ( )])plot f x f x . 
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21. Найдите неопределенный интеграл функции siny x x  в области ее 

определения. Постройте в одной системе график этой функции и какой-нибудь 

первообразной. 

Пример решения 

Для нахождения неопределенного интеграла функции ( )y f x  можно 

воспользоваться командой ( ( ), )int f x x . Ее результатом является первообразная  

при нулевом значении произвольной постоянной. Для построения графиков в 

одной системе координат удобна в использовании встроенная команда 

1 2([ ( ), ( )])plot f x f x . 

22. Убедитесь, что Г-функция Эйлера определяется как зависящий от 

параметра z несобственный интеграл 1

0

t ze t dt


 
  и вычисляется при конкретных 

значениях параметра с помощью команды GAMMA(z) или Г(z). Проверьте 

истинность тождества Г(n+1)   n! 

Пример решения 

 Проверка представления Г-функции Эйлера  с помощью зависящего от 

параметра z несобственного интеграла 1

0

t ze t dt


 
  с помощью команды testeq(): 

>  

 . 

Нахождение приближенных значений Г-функции при конкретных 

значениях параметра: 

>  

 

>  

. 

Проверка тождества Г(n+1)   n! двумя способами: 

>  

 

или 

>  

. 
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23. Постройте кривую, заданную параметрически уравнениями

2sh , 3chx t y t  . 

Пример решения 

Для построения графика можно использовать следующую команду: 

>  

 

24. Постройте кривую ρ 1 2sin3   , заданную полярными 

координатами, используя специальные опции встроенной команды plot(). 

Пример решения 

>  

 
25. Постройте заданную в полярных координатах кривую с помощью 

графического пакета plots. 

Пример решения 

>  
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26. Постройте множество точек с координатами (0, 1), (2, 4) и (3, 3) на 

плоскости, используя команду plot(). 

Пример решения 

Самый простой способ ‒ перечислить координаты этих точек как список 

списков в обязательном аргументе команды и определить форму вывода через 

дополнительную стилевую опцию: 

>  
 

 
 

27. Постройте ломаную линию с вершинами в точках (0, 1), (2, 4) и (3, 3). 

Пример решения 

Задание выполнить можно аналогично предыдущему упражнению без 

дополнительных параметров: 

>  
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28. Постройте на плоскости точки, соответствующие первым 20 членам 

числовой последовательности 
3 2

2 1
n

n
a

n





, и определите по чертежу, с какого 

номера все члены последовательности попадают в  -полосу, центрированную 

относительно прямой 3 / 2y   при 0,1  . 

Пример решения 

>  

>

 

 

>  

 
29. Выполните приведенные примеры команд для разных случаев 

анимации и «проиграйте» результат. 

Пример решения 
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30. Постройте график решения дифференциального уравнения 

2 0y xy x y     с начальными условиями (0) 0, (0) 1y y   в интерва- 

ле [ 4; 5] . 

Пример решения 

>  

>  

 

31. Постройте с помощью команды DEplot фазовый портрет системы 

дифференциальных уравнений 31
,

2
x y y x x     для нескольких наборов 

начальных условий: х(0)   1, у(0)   0,2; х(0)   0, у(0)   1; х(0)   1, у(0)   0,4. 

Пример решения 

>  

>  
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32. Найдите особую точку уравнения, постройте в одной системе 

координат поле направлений уравнения, интегральную кривую, проходящую 

через точку (0, 1), и сами точки (особую и начальную). 

Пример решения 

>  

>  
>  

>  

 

33. Постройте в поле направлений уравнения 
2

y
x

   его частное решение

2ln 5y x  . 

Пример решения 

>  
>  

>  

>  

>  
>  
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34. Аппроксимируйте функцию arccos 1y x   частичной суммой 6S  ряда 

Фурье по системе многочленов Чебышева с весовой функцией 
2

1
( )

1
x

x
 


. 

Убедитесь, что на промежутке 1 1x       , где   ‒ сколь угодно малое 

положительное число, абсолютная погрешность приближения не превысит 0,1. 

Пример решения 

Вычислим с помощью простого цикла семь коэффициентов Эйлера ‒ 

Фурье по ортогональным полиномам Чебышева I рода: 

>  

    

    

Построим график искомой частичной суммы 6S  в полосе шириной 0,2 

относительно графика функции arccos 1y x  , чтобы убедиться, что он 

полностью лежит в ней: 
>  

 
Построим график функции, описывающей абсолютное значение 

отклонения функций на заданном промежутке: 

>  
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35. 1) Найдите для функции-оригинала
3( ) sin 2f t t t  изображение 

Лапласа по определению через несобственный интеграл и сравните с 

результатом работы команды laplace() пакета inttrans.  

2) Найдите оригинал по изображению 
3 2

2
( )

2 5

p
F p

p p p




 
 с помощью 

команды invlaplace() пакета inttrans. 

3) Найдите для кусочно-непрерывной функции-оригинала изображение 

Лапласа, если она задана следующим образом ( 0a  ): 

1, (0, ),

0, ( , 2 ),

2
, (2 , 3 ),

( )

4
, (3 , 4 ),

0, ( , ).

t a

t a a

t a
t a a

f t a

a t
t a a

a

t a






 




 



  

 

Пример решения 

1) Изображение Лапласа будет найдено по определению, если ввести 

ограничение на комплексный параметр p. Напомним, что равномерная 

сходимость интеграла будет обеспечена при условии 0Re( )p   , где 0  ‒ 

порядок роста функции оригинала. 
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. 

Сравните с результатом, полученным в результате применения команды 

laplace() пакета inttrans: 

>  

>  

. 

2) Для нахождения оригинала по изображению используем команду 

обратного преобразования Лапласа того же специализированного пакета 

интегральных преобразований: 

>  

>  

. 

3) Для нахождения изображения кусочно-непрерывной функции 

определим ее с помощью одной формулы, используя функцию Хевисайда, и 

введем в Maple как функциональный оператор: 

>  

После этого применим к ней преобразование Лапласа, ограничив 

предварительно область значений параметра а: 

>  

. 

36. Определите в Maple функцию Arctgw z  и найдите ее значение при 

2 3 3

3

i
z

 
 . 
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Пример решения 

Определим арктангенс через логарифм как функциональный оператор, а 

затем найдем все значения в заданной точке, применив для упрощения 

результата команду evalc(). 

>  

 

>  

. 

37. Постройте в комплексной плоскости множество точек, определенное 

системой неравенств 2, 4z z  . 

Пример решения 

Зададим комплексную переменную z в алгебраическом виде и 

воспользуемся командой inequal() графического пакета plots: 
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3. Лабораторный практикум 

Лабораторная работа №1 

Операции с математическими выражениями и функциями в Maple 

 

Цель: закрепить приобретенные знания по решению базовых 

математических задач в системе Maple. 

Задание 1. Упростите алгебраическое выражение. 

1.1. 
4 3 2 3 2

4 3 2 3 2

11 9 18 9 26 24
:

3 7 27 18 8 19 12

x x x x x x x

x x x x x x x

      

      
. 

1.2. 
4 3 2 2

4 3 2 2

5 10 100 330 225 2 15
:

7 6 3 2

x x x x x x

x x x x x x

     

     
. 

1.3. 
3 2 4 2

3 2 4 3

3 9 27 49 882 3969
:

5 15 72 8 27 216

x x x x x

x x x x x x

    

     
. 

1.4. 
5 4 4 3

3 2 2

5 16 80 3 10 16 80
:

2 4 8 2 4

x x x x x x

x x x x x

     

    
. 

1.5. 
5 4 3 2 3 2

4 3 2 3 2

9 36 9 90 36 72 6 12 8
:

9 11 4 3 4

x x x x x x x x

x x x x x x x

       

     
. 

1.6. 
4 2 3 2

5 4 2 3 2

7 126 567 3 9 27
:

8 27 216 5 15 72

x x x x x

x x x x x x x

    

     
. 

1.7. 
3 2 5 4 3 2

2 4 3 2

6 12 8 9 36 9 90 36 72
:

3 4 9 11 4

x x x x x x x x

x x x x x x

       

     
. 

1.8. 
4 3 2 2

4 3 2 3 2

7 6 3 2
:

5 10 100 330 225 2 15

x x x x x x

x x x x x x x

     

     
. 

1.9. 
5 4 3 2 2

4 3 2 3 2

4 40 100 80 320 256 8 16
:

9 11 4 3 3

x x x x x x x

x x x x x x

      

    
. 

1.10. 
3 4 3 2

2 3 2

3 2 3 5 2
:

40 400 9 351 3240 3600

x x x x x x

x x x x x

     

    
. 

Задание 2. Приведите выражение к многочлену стандартного вида. 

2.1. 2(2 1)(3 5)(5 2)x x x   .   2.2. 2(3 2)(5 6)(2 3)x x x   . 
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2.3. 2(4 3)(3 1)(5 2)x x x   .   2.4. 2(4 3)(3 2)(2 1)x x x   . 

2.5. 2(5 4)(3 2)(4 1)x x x   .   2.6. 2(2 5)(3 2)(4 3)x x x   . 

2.7. 2(7 6)(3 4)(5 3)x x x   .   2.8. 2(2 7)(5 6)(3 4)x x x    

2.9. 2(2 9)(4 3)(3 1)x x x   .   2.10. 2(3 8)(2 3)(4 5)x x x   . 

Задание 3. Разложите многочлен на множители. 

3.1. 
4 3 214 46 82 138 120x x x x    .  3.2. 

4 3 23 22 4 40x x x x    . 

3.3. 
4 3 24 31 33 93 63x x x x    .  3.4. 

4 3 216 76 68 76 84x x x x    . 

3.5. 
4 3 26 23 9 92 60x x x x    .  3.6. 

4 3 29 11 4x x x x    . 

3.7. 
4 3 27 21 63 108x x x x    .  3.8. 

4 3 26 4 30 45x x x x    . 

3.9. 
4 3 22 14 12 56 80x x x x    .  3.10. 

4 3 216 67 64 252x x x x    . 

Задание 4. Постройте график многочлена 5( )P x  и найдите все его корни. 

4.1. 5 4 3 2
5( ) 12 108 315 360 303 252P x x x x x x      . 

4.2. 5 4 3 2
5( ) 7 99 511 1149 994 120P x x x x x x      . 

4.3. 5 4 3 2
5( ) 2 9 34 231 346 120P x x x x x x      . 

4.4. 5 4 3 2
5( ) 3 50 299 760 748 240P x x x x x x      . 

4.5. 5 4 3 2
5( ) 7 25 37 217 234 72P x x x x x x      . 

4.6. 5 4 3 2
5( ) 2 11 41 404 948 720P x x x x x x      . 

4.7. 5 4 3 2
5( ) 6 65 195 5 561 180P x x x x x x      . 

4.8. 5 4 3 2
5( ) 6 15 372 771 120 300P x x x x x x      . 

4.9. 5 4 3 2
5( ) 3 7 115 63 412 140P x x x x x x      . 

4.10. 5 4 3 2
5( ) 12 40 547 778 136 192P x x x x x x      . 

Задание 5. Разложите рациональную дробь на сумму простейших дробей. 

5.1. 
4 3

2 2 2

5 7 5 4

( 4)( 2) ( 1)

x x x

x x x

  

  
.   5.2. 

4 3

2 2 2

4 6 5 4

( 3)( 1) ( 4)

x x x

x x x

  

  
. 



88 

 

5.3. 
4 3

2 2 2

5 7 3 1

( 2)( 1) ( 9)

x x x

x x x

  

  
.   5.4. 

4 3

2 2 2

3 2 4 3

( 2)( 3) ( 1)

x x x

x x x

  

  
. 

5.5. 
4 3

2 2 2

3 7 2 4

( 1)( 4) ( 9)

x x x

x x x

  

  
.   5.6. 

4 3

2 2 2

2 3 5 4

( 1)( 3) ( 4)

x x x

x x x

  

  
. 

5.7. 
4 3

2 2 2

2 5 3 1

( 1)( 2) ( 9)

x x x

x x x

  

  
.   5.8. 

4 3

2 2 2

3 4 5 2

( 2)( 3) ( 4)

x x x

x x x

  

  
. 

5.9. 
4 3

2 2 2

2 3 2 4

( 4)( 2) ( 9)

x x x

x x x

  

  
.   5.10. 

4 3

2 2 2

4 3 2 5

( 1)( 3) ( 4)

x x x

x x x

  

  
. 

Задание 6. Решите графически уравнение и найдите его приближенные 

корни с точностью до 
510 . 

6.1. 2ln ( 1) 3cos2 1x x   .    6.2. 2ln ( 2) 2sin3 0,5x x    . 

6.3. 2ln ( 1) 2cos3 1,5x x   .    6.4. 2ln ( 2) 2sin3 1,5x x   . 

6.5. 2ln ( 2) 1,5cos2 1x x   .    6.6. 2ln ( 1) 2,5sin 2 1x x   . 

6.7. 2ln ( 2) 2cos2 1x x        6.8. 2ln ( 3) 3sin 2 1,5x x   . 

6.9. 2ln ( 3) 3cos2 2x x    .    6.10. 2ln ( 1) 3sin 2 1x x    . 

Задание 7. Докажите, что lim n
n

a a


 , определив номер εn , начиная с 

которого все члены последовательности ( )na  попадут в ε -окрестность точки a. 

Проиллюстрируйте полученный результат с помощью чертежа в Maple, 

положив ε 0,1 . 

7.1. 
5 2 5

,
2 1 2

n

n
a a

n


 


.     7.2. 

4 1 4
,

3 1 3
n

n
a a

n


 


. 

7.3. 
5 2 5

,
3 1 3

n

n
a a

n


 


.     7.4. 

3 2 3
,

2 1 2
n

n
a a

n


 


. 

7.5. 
7 2 7

,
2 1 2

n

n
a a

n


 


.     7.6. 

6 5 6
,

5 1 5
n

n
a a

n


 


. 

7.7. 
7 3 7

,
3 5 3

n

n
a a

n


 


.     7.8. 

7 4 7
,

4 1 4
n

n
a a

n


 


. 
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7.9. 
7 5 7

,
5 1 5

n

n
a a

n


 


.     7.10. 

7 3 7
,

6 1 6
n

n
a a

n


 


. 

Задание 8. Вычислите пределы числовых последовательностей. 

8.1. 1)  2 2lim 1 1
n

n n n


   ;   2) 

1
2

2

3 6 7
lim

3 20 1

n

n

n n

n n





  
    

. 

8.2. 1)  2lim ( 2) 3
n

n n n n


   ;   2) 

2 1
2

2

2 21 7
lim

2 18 9

n

n

n n

n n





  
    

. 

8.3. 1)  2lim ( 2) 2 3
n

n n n n


    ;  2) 

1
2

2

3 5
lim

3 5 7

n

n

n n

n n





 
    

. 

8.4. 1)  lim ( 2)( 1) ( 1)( 3)
n

n n n n


     ; 2) 

/2
2

2

3 6
lim

5 1

n

n

n n

n n

  
    

. 

8.5. 1)  2 2lim 3 2 3
n

n n n


    ;   2) 

3 2
2

2

6 5
lim

5 5

n

n

n n

n n





  
    

. 

8.6. 1)  lim 2 3
n

n n n


   ;   2) 

2 5
2

2

3 4 1
lim

3 2 7

n

n

n n

n n





  
    

. 

8.7. 1)  2lim 3 2
n

n n n


   ;    2) 

2
2

2

7 18 15
lim

7 11 15

n

n

n n

n n





  
    

. 

8.8. 1)  lim ( 5)
n

n n n


  ;    2) 
2

2

2 5 7
lim

2 5 3

n

n

n n

n n

  
    

. 

8.9. 1)  lim ( 1)
n

n n n


  ;    2) 

1 2
2

2

4 4 1
lim

4 2 3

n

n

n n

n n





  
    

. 

8.10. 1)  lim 2 3 4
n

n n n


    ;  2) 

1 3
2

2

3 6 1
lim

3 2 4

n

n

n n

n n





  
    

. 

Задание 9. Для заданной кусочно-непрерывной функции выполните 

следующие действия: 



90 

 

1. Определите ее через функциональный оператор и постройте график. 

2. В точке разрыва и на бесконечности найдите односторонние пределы. 

3. Найдите производную и неопределенный интеграл на каждом из 

промежутков непрерывности. 

4. Постройте в одной системе координат графики функции, производной 

и какой-нибудь первообразной. 

5. Найдите площадь криволинейной трапеции, ограниченной графиком 

функции и прямыми 1, 5, 0x x y   . Сделайте чертеж. 

9.1. 
0,5

5sin 2 , π;

7 , π.x

x x
y

e x

 
 

 
   9.2. 

0,3

3cos2 , π;

5 , π.x

x x
y

e x

 
 

 
 

9.3. 
0,4

4sin 2 , π;

6 , π.x

x x
y

e x

 
 

 
   9.4. 

0,4

4cos2 , π;

6 , π.x

x x
y

e x

 
 

 
 

9.5. 
0,3

3sin 2 , π;

5 , π.x

x x
y

e x

 
 

 
   9.6. 

0,5

5cos2 , π;

7 , π.x

x x
y

e x

 
 

 
 

9.7. 
0,2

2sin 2 , π;

4 , π.x

x x
y

e x

 
 

 
   9.8. 

0,6

6cos2 , π;

8 , π.x

x x
y

e x

 
 

 
 

9.9. 
0,6

6sin 2 , π;

8 , π.x

x x
y

e x

 
 

 
   9.10. 

0,2

2cos2 , π;

4 , π.x

x x
y

e x

 
 

 
 

Задание 10. Постройте кривые на плоскости. Для кривой 2-го порядка 

(пункт 2) найдите каноническое уравнение с помощью ортогонального 

преобразования. 

10.1. 1) 0,60,5 sin(5 3)xy e x  ; 2) 2 25 6 5 24 32 0x xy y x     ; 

 3) 
2( sin ),

2(1 cos );

x t t

y t

 


 
  4) 

π
ρ 1 2sin 3φ .

4

 
   

 
 

10.2. 1) 0,50,6 cos(6 1)xy e x  ; 2) 
2 29 12 4 24 16 7 0x xy y x y      ; 

 3) 
3( sin ),

3(1 cos );

x t t

y t

 


 
  4) 

π
ρ 1 2cos 3φ .

4

 
   

 
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10.3. 1) 0,50,4 sin(4 1)xy e x  ; 2) 
2 27 60 32 14 60 7 0x xy y x y      ; 

 3) 

3

3

2cos ,

sin ;

x t

y t

 




   4) 
π

ρ 1 sin 3φ .
4

 
   

 
 

10.4. 1) 0,40,7 cos(5 4)xy e x  ; 2) 
2 211 20 4 20 8 1 0x xy y x y      ; 

 3) 

3

3

sin 2 ,

cos 3 ;

x t

y t

 




   4) 
π

ρ 2 2cos 4φ .
3

 
   

 
 

10.5. 1) 0,70,8 sin(6 5)xy e x  ; 2) 
2 24 4 16 8 15 0x xy y x y      ; 

 3) 
2(cos sin ),

2(sin cos );

x t t t

y t t t

 


 
  4) 

π
ρ 1 2sin 3φ .

4

 
   

 
 

10.6. 1) 0,30,2 cos(4 1)xy e x  ; 2) 
2 24 4 3 4 7 0x xy y x y      ; 

 3) 
22sin ,

sin 2 ;

x t

y t

 




   4) 
π

ρ 1 2cos 3φ+ .
6

 
   

 
 

10.7. 1) 0,30,7 sin(7 2)xy e x  ; 2) 
2 24 12 9 20 30 16 0x xy y x y      ; 

 3) 
2

2sin 2 ,

4cos ;

x t

y t






   4) 
π

ρ 5 4sin 3φ .
6

 
   

 
 

10.8. 1) 0,40,3 cos(4 3)xy e x  ; 2) 
2 24 4 6 3 4 0x xy y x y      ; 

 

3

3

1 2cos ,

1 2sin ;

x t

y t

  


  

   4) 
π

ρ 1 2sin 5φ .
4

 
   

 
 

10.9. 1) 0,40,6 sin(5 2)xy e x  ; 2) 
2 24 12 9 2 3 2 0x xy y x y      ; 

 3) 

3

3

2 sin ,

1 cos ;

x t

y t

  


 

   4) 
π

ρ 1 2cos 5φ .
6

 
   

 
 

10.10. 1) 0,30,8 cos(6 1)xy e x  ; 2) 
2 24 16 16 8 22 5 0x xy y x y      ; 

 3) 
2

2cos2 ,

2cos ;

x t

y t






   4) 
π

ρ 3 2cos 3φ .
4

 
   

 
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Темы для самоконтроля 

1. Справочная система Maple. 

2. Ввод команд и их выполнение. 

3. Константы, встроенные функции и специализированные пакеты. 

4. Выражения и их преобразования. 

5. Решение уравнений, неравенств и их систем. 

6. Графика и анимация. 

7. Нахождение пределов функций. 

8. Дифференцирование функций. 

9. Интегрирование функций. 

10. Создание пользовательских процедур. Элементы программирования. 

 

Лабораторная работа №2 

Числовые ряды 

 

Цель: научиться исследовать числовые ряды на сходимость и 

контролировать результаты с помощью средств системы Maple. 

Задание 1. Постройте в прямоугольной системе координат 10 первых 

членов ряда и убедитесь в том, что для него выполняется необходимый признак 

сходимости. 

Найдите сумму ряда и сравните с результатом, полученным в Maple. 

Определите минимальный порядок частичной суммы Sn ряда, 

приближающей сумму S ряда с точностью, не превышающей 0,1. 

Проиллюстрируйте свой результат с помощью графических средств 

системы Maple. 

1.1. 1) 
2

1

6

9 12 5n n n



  
 ;    2) 

  3

4 5

1 2n

n

n n n







 
 . 

1.2. 1) 
2

2

24

9 12 5n n n



  
 ;    2) 

  1

6

3 2n

n

n n n







 
 . 
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1.3. 1) 
2

1

6

9 6 8n n n



  
 ;    2) 

  1

5 3

1 3n

n

n n n







 
 . 

1.4. 1) 
2

1

9

9 21 8n n n



  
 ;     2) 

  2
3

4 2

1 2n

n

n n







 
 . 

1.5. 1) 
2

0

2

4 8 3n n n



  
 ;     2) 

  1

1

1 3n n n n



  
 . 

1.6. 1) 
2

1

14

49 28 45n n n



  
 ;    2) 

 2
3

3 5

1n

n

n n








 . 

1.7. 1) 
2

1

3

9 3 2n n n



  
 ;     2) 

  1

1

2 3n n n n



  
 . 

1.8. 1) 
2

1

7

49 7 12n n n



  
 ;    2) 

 2
3

1

4n n n



 
 . 

1.9. 1) 
2

2

1

2n n n



  
 ;     2) 

  1

3 2

1 2n

n

n n n







 
 . 

1.10. 1) 
2

1

14

49 14 48n n n



  
 ;    2) 

  3

2

1 2n

n

n n n







 
 . 

Задание 2. Докажите, что ряд сходится абсолютно и удовлетворяет 

условиям теоремы Лейбница. 

Найдите минимальный порядок частичной суммы Sn ряда, 

приближающей его сумму S с точностью α . 

Проиллюстрируйте свой результат с помощью графических средств СКА 

Maple. 

2.1.  
1

2
1

1
1 ,   α 0,01

3

n

n n






  .   2.2. 
 

1

1

1
,   0,01

!

n

n n






  . 

2.3.  
 

1

3
1

1
1 ,   0,001

2

n

n n






   .  2.4.  
 0

1
1 ,   0,001

! 2 1

n

n n n





  


 . 
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2.5.  
 3

1

2 1
1 ,   0,01

1

n

n

n

n n






  


 .  2.6. 

 
 1

1
,   0,0001

2 1 !

n

n n






 


 . 

2.7. 
 

1

1
,   0,1

2

n

n
n

n



 
  .   2.8. 

  2

1

1
,   0,1

3

n

n
n

n



 
  . 

2.9. 
 

   
2 2

1

1
,   0,001

2 1 2 1

n

n

n

n n





 
 

 
 . 2.10. 

 
 1

1
,   0,0001

2 1 !!

n

n n






 


 . 

Задание 3. Докажите справедливость равенства, убедившись в 

сходимости соответствующего числового ряда. Проведите контрольные 

расчеты в системе Maple. 

3.1. 
!

lim 0
nn

n

n
 .     3.2. 

 
lim 0

2 !

n

n

n

n
 . 

3.3. 
2 !!

lim 0
nn

n

n
 .     3.4. 

 
 

2
lim 0

2 1 !

n

n

n

n



. 

3.5. 
 

2

2 !
lim 0

2 !n

n

n
 .    3.6. 

 
2

lim 0
!

n

n

n

n
 . 

3.7. 
 

2

2 !!
lim 0

5nn

n


 .    3.8. 

2

lim 0
!n

n

n
 . 

3.9. 
 1 !

lim 0
nn

n

n


 .    3.10. 

 
lim 0

2 1 !

n

n

n

n



. 

Темы для самоконтроля 

1. Понятие числового ряда. 

2. Сходимость и сумма числового ряда.  

3. Необходимое условие сходимости числового ряда. 

4. Признаки сравнения знакоположительных рядов. 

5. Признаки Д’Аламбера и Коши (радикальный). 

6. Интегральный признак. Оценка остатка сходящегося ряда. 

7. Абсолютная и условная сходимости числового ряда. 
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8. Свойства абсолютно сходящихся рядов. 

9. Свойства условно сходящихся рядов. 

10. Теорема Лейбница. Оценка остатка лейбницевского ряда. 

Лабораторная работа №3 

Функциональные ряды. Степенные ряды 

 

Цель: научиться находить область сходимости функциональных рядов, 

определять тип их сходимости, раскладывать функции в степенные ряды и 

контролировать результаты с помощью средств системы Maple. 

Задание 1. Найдите область сходимости функционального ряда, 

постройте график его суммы и сравните с полученным результатом. 

1.1. 

 21

2 1

1 3 4 2
n

n

n

n x x






  

 .   1.2. 

 21

1 1

2 4 5
n

n

n

n x x








 
 . 

1.3. 

 21

3 1

2 1 4 8 5
n

n

n

n x x








  
 .   1.4. 

 21

1

2 1 3 8 6
n

n

n

n x x






  

 . 

1.5. 

 21

2 1 1

6 10
n

n

n

n x x








 
 .   1.6. 

 21

1 1

2 4 5
n

n

n

n x x








 
 . 

1.7. 

 21

3 1

2 1 5 7
n

n

n

n x x








  
 .   1.8. 

 21

5 1

2 3 2 4 3
n

n

n

n x x








  
 . 

1.9. 

 21

2 1

2 3 10 9
n

n

n

n x x






  

 .  1.10. 

 21

2 5 1

7 3 4 2
n

n

n

n x x








  
 . 

Задание 2. Докажите равномерную сходимость функционального ряда на 

отрезке [0,1] . Найдите наименьшее значение minn , при котором 

min
| ( ) | ε [0,1]nr x x   . Убедитесь, что при ε=0,01 график частичной суммы 

minnS  ряда  не выходит на отрезке [0,1] за пределы ε-полосы, центрированной 

относительно графика суммы ряда. 
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2.1.  
1

1
7 11

n
n

n

x

n








 .     2.2.  
1

1
5 6

n
n

n

x

n








 . 

2.3.  
1

1
4 6

n
n

n

x

n








 .     2.4.  
1

1
4 5

n
n

n

x

n








 . 

2.5.  
1

1
5 9

n
n

n

x

n








 .     2.6.  
1

1
3 4

n
n

n

x

n








 . 

2.7.  
1

1
6 7

n
n

n

x

n








 .     2.8.  
1

1
6 11

n
n

n

x

n








 . 

2.9.  
1

1
3 5

n
n

n

x

n








 .     2.10.  
1

1
7 10

n
n

n

x

n








 . 

Задание 3. Вычислите интеграл с точностью до 0,001 и 

проконтролируйте результат с помощью расчетов в системе Maple. Обоснуйте 

свое решение. 

3.1. 
2

0,1
6

0

xe dx
 .      3.2.  

0,1
2

0

sin 3x dx . 

3.3. 
1

2

0

cos x dx .      3.4. 
0,5

4 4
0 1

dx

x
 . 

3.5. 
0,1 2

0

1 xe
dx

x


 .      3.6. 

 1

0

ln 1 5x
dx

x


 . 

3.7. 
1,5

3 3
0 27

dx

x
 .      3.8. 

2
0,2

3

0

xe dx
 . 

3.9.  
0,2

2

0

sin 5x dx .     3.10.  
0,5

2

0

cos 4x dx . 

Темы для самоконтроля 

1. Понятие функционального ряда и его области сходимости. 

2. Абсолютная и условная сходимости функционального ряда. 

3. Равномерная сходимость функционального ряда. 
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4. Теорема о непрерывности суммы функционального ряда. 

5. Теоремы об интегрировании и дифференцировании функционального 

ряда. 

6. Интервал и радиус сходимости степенного ряда. 

7. Теорема о равномерной сходимости степенного ряда.  

8. Ряд Тейлора и его остаток.  

9. Разложение функции в ряд Тейлора.  

10. Основные разложения в ряд Тейлора. 

Лабораторная работа №4 

Ряды Фурье 

 

Цель: научиться раскладывать функцию в ряд Фурье по 

тригонометрической системе функций и по ортогональным полиномам, 

определять область сходимости полученного ряда к порождающей его 

функции, контролировать результаты с помощью средств системы Maple. 

Задание 1. Для 2π-периодической кусочно-непрерывной функции ( )f x

по ее аналитическому определению на главном периоде получите разложение в 

тригонометрический ряд Фурье. Убедитесь в правильности результата, проведя 

расчеты в системе Maple.  

Создайте пользовательскую процедуру-функцию, осуществляющую 

построение тригонометрического ряда Фурье для произвольной функции, 

удовлетворяющей теореме Дирихле. 

Постройте в одной системе координат на промежутке [ 3π, 3π]  графики 

частичных сумм 1( )S x , 3( )S x , 7 ( )S x  ряда и его суммы ( )S x . Сравните 

полученный результат с графиком порождающей функции на главном периоде. 

Анимируйте процесс построения графиков сумм ряда, взяв в качестве 

параметра порядковый номер частичной суммы. 
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1.1. 
π 2 , π 0;

( )
π, 0 π.

x x
f x

x

   
 

  
  1.2. 

π 2 , π 0;

( ) π
,      0 π.

2

x x

f x
x

   

  


 

1.3. 

π
, π 0;

2
( )

π
,   0 π.

2

x
x

f x

x


  

 
  


  1.4. 

π
, π 0;

2
( )

π
,    0 π.

2

x x

f x

x


   

 
  


 

1.5. 

π
, π 0;

4 2
( )

π
,    0 π.

4

x
x

f x

x


   

 
  


  1.6. 

π
, π 0;

2 4
( )

π
,   0 π.

4

x
x

f x

x


   

 
  


 

1.7. 
2 π, π 0;

( )
π,   0 π.

x x
f x

x

    
 

  
  1.8. 

π
, π 0;

2
( )

π
,   0 π.

2

x
x

f x

x


  

 
  


 

1.9. 

π
, π 0;

4 2
( )

π
,   0 π.

4

x
x

f x

x


    

 
  


  1.10. 
π , π 0;

( )
π,   0 π.

x x
f x

x

    
 

 
 

Задание 2. Разложите в ряд Фурье 2x -периодическую функцию ( )y f x , 

заданную на промежутке 1(0, )x  формулой y ax b  , а на 1 2[ , ]x x  ‒ формулой

y c . 

Убедитесь в правильности результата, проведя расчеты в системе Maple. 

Модифицируйте созданную ранее процедуру (см. задание 1). 

Постройте в одной системе координат графики частичных сумм 1( )S x , 

3( )S x , 7 ( )S x  ряда и его суммы ( )S x  на промежутке 2 2[ 2 , 2 ]x x . Сравните 

полученный результат с графиком порождающей функции на главном периоде. 

Анимируйте процесс построения графиков сумм ряда, взяв в качестве 

параметра порядковый номер частичной суммы. 

2.1. 1 21, 2, 1, 2, 5a b c x x      .  2.2. 1 22, 2, 2, 3, 5a b c x x      . 
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2.3. 1 23, 1, 2, 2, 4a b c x x      .  2.4. 1 20,5, 1, 3, 3, 5a b c x x      . 

2.5. 1 20,5, 2, 3, 3, 5a b c x x       . 2.6. 1 21, 1, 2, 2, 6a b c x x       . 

2.7. 1 22, 3, 2, 4, 6a b c x x         2.8. 1 22, 1, 2, 1, 3a b c x x       . 

2.9. 1 20,75, 1, 3, 2, 4a b c x x      . 2.10. 1 20,5, 3, 2, 2, 6a b c x x      . 

Задание 3. Для графически заданной на промежутке функции как 

комбинации квадратичной и линейной постройте три разложения в 

тригонометрический ряд Фурье, считая, что функция определена: 

- на полном периоде; 

- на полупериоде (является четной); 

- на полупериоде (является нечетной). 

Убедитесь в правильности результата, проведя расчеты в системе Maple.  

Постройте графики сумм полученных рядов на промежутке, 

превышающем длину заданного в 3 раза. Сравните с графиками порождающих 

их функций. 

3.1.  

 

3.2. 

 

 

3.3. 
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3.4. 

 

3.5. 

 

3.6. 

 

3.7. 

 

3.8. 
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3.9. 

 

3.10. 

 

Задание 4. Разложите функцию в ряд Фурье по многочленам Лежандра и 

Чебышева на промежутке [ 1, 1] . Создайте пользовательские процедуры, 

осуществляющие построение частичной суммы ряда для абсолютно 

интегрируемой функции по этим ортогональным полиномам. 

Постройте в одной системе координат на промежутке [ 1, 1]  графики 

заданной функции и построенных частичных сумм ряда Фурье. 

Экспериментально найдите наименьший порядок частичной суммы, 

равномерно аппроксимирующей на всем промежутке заданную функцию с 

точностью 0,1. Проиллюстрируйте свой результат. 

Разложите функцию в тригонометрический и степенной ряды на 

промежутке [ 1, 1] . Найдите наименьший порядок частичной суммы, 
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равномерно аппроксимирующей на всем промежутке заданную функцию с 

точностью 0,1. Проиллюстрируйте свой результат.  

Изобразите в одной системе координат на промежутке [ 1, 1]  графики 

заданной функции и всех построенных аппроксимирующих ее многочленов. 

Проведите сравнительный анализ полученных результатов. 

4.1. 1) 34sin (2 )y x ; 2) arccos 1y x   . 4.2. 1) 3sin (3 )y x ; 2) arccos 2y x  . 

4.3. 1) 3sin (2 )y x  ; 2) arccos 1y x  . 4.4. 1) 3sin (4 )y x ; 2) 2arccos 1y x  . 

4.5. 1) 32sin (2 )y x ; 2) 3arccos 1y x  . 4.6. 1) 3sin ( 3 )y x  ; 2) 2arccos 1y x  . 

4.7. 1) 33sin (2 )y x ; 2) 3arccos 1y x  . 4.8. 1) 32sin (4 )y x  2) 3arccos 2y x  . 

4.9. 1) 32sin (3 )y x ; 2) arccos 3y x  . 4.10. 1) 3sin (2 )y x ; 2) arccos 3y x  . 

Темы для самоконтроля 

1. Ортогональные системы тригонометрических функций. 

2. Разложение 2π-периодической функции в тригонометрический ряд 

Фурье. Теорема Дирихле. 

3. Разложение 2l-периодической функции в тригонометрический ряд 

Фурье. Частные случаи разложений. 

4. Комплексная форма ряда Фурье. 

5. Бесконечномерное евклидово пространство непрерывных на замкнутом 

отрезке функций. 

6. Ортогональные полиномы. Ортогональность с весом. 

7. Ряды Фурье по ортогональной системе функций. 

8. Минимальное свойство коэффициентов Эйлера – Фурье. 

9. Неравенство Бесселя. 

10. Уравнение замкнутости. 
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Лабораторная работа №5 

Обыкновенные дифференциальные уравнения 1-го порядка 

 

Цель: научиться графически и аналитически находить общее, частное и 

особое решения основных типов уравнений 1-го порядка, строить для 

простейших геометрических задач модели в виде дифференциального 

уравнения 1-го порядка и контролировать результаты с помощью средств 

системы Maple. 

Задание 1. Для данного дифференциального уравнения методом изоклин 

постройте интегральную кривую, проходящую через точку M . 

1.1.  2, 1,  2 .y y x M      1.2.  2 ,  0,  5 .yy x M    

1.3.  22 ,  1,  2 .y y M       1.4.  
2

,  1,  1 .
3

x
y M

y
   

1.5.    1 ,  1,  3 2 .y y x M      1.6.  0,  2,  3 .yy x M      

1.7.  23 ,  1,  2 .y y M      1.8.  2 ,  2,  3 .xy y M   

1.9.    2 2 ,  2,  2 .y x y M      1.10.  2 ,  1,  1 / 2 .y x y M    

Задание 2. 1) Найдите линию, проходящую через точку 
0M  и 

обладающую тем свойством, что в любой ее точке M  нормальный вектор MN  

с концом на оси Oy  имеет длину, равную a , и образует острый угол с 

положительным направлением оси Oy . Сделайте чертеж. 

2) Найдите линию, проходящую через точку 
0M , и обладающую тем 

свойством, что в любой ее точке M  касательный вектор MN  с концом на 

оси Ox  имеет проекцию на ось Ox , обратно пропорциональную абсциссе 

точки M . Коэффициент пропорциональности равен a . Сделайте чертеж. 

2.1. 1)  0 15,  1 ,  25;M a      2)  0 1,  ,  1 2.M e a    

2.2. 1)  0 9,  3 ,  15;M a       2)  0 2,  ,  2.M e a    

2.3. 1)  0 12,  2 ,  20;M a      2)  0 1,  ,  1.M e a    
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2.4. 1)  0 6,  4 ,  10;M a      2)  0 2,  1 ,  2.M e a   

2.5. 1)  0 3,  5 ,  5;M a       2)  2
0 1,  1 ,  1 4.M e a   

2.6. 1)  0 4,  1 ,  5;M a       2)  0 1,  1 ,  1.M e a   

2.7. 1)  0 12, 3 ,  13;M a      2)  0 1,  1 ,  1 2.M e a   

2.8. 1)  0 15,  5 ,  17;M a      2)  0 2,  ,  2.M e a   

2.9. 1)  0 20, 3 ,  29;M a      2)  0 2,  1 ,  1 4.M e a   

2.10. 1)  0  5, 2 ,  13;M a      2)  2
0 4,  1 ,  4.M e a    

Задание 3. Найдите общий интеграл уравнения. Постройте на одном 

чертеже вблизи особой точки уравнения поле направлений и какую-либо 

интегральную кривую. Сделайте вывод о типе особой точки. 

3.1. 
4 21 25

24 25

x y
y

x y

 
 

 
.    3.2. 

15 13

9 11

x y
y

x y

  
 

 
. 

3.3. 
10 26 16

37 38

x y
y

x y

  
 

 
.   3.4. 

12 5 34

2 6

x y
y

x y

  
 

 
. 

3.5. 
30 7 51

4 7

x y
y

x y

  
 

 
.    3.6. 

6 5 4

4

x y
y

y

  
 


. 

3.7. 
4(3 8 11)

31 32

x y
y

x y

 
 

 
.    3.8. 

10 33 43

30 31

x y
y

x y

 
 

 
. 

3.9. 
7 57 64

63 64

x y
y

x y

 
 

 
.    3.10. 

20 77 97

76 77

x y
y

x y

 
 

 
. 

Задание 4. Найдите решение задачи Коши. Сделайте чертеж 

интегральной кривой. 

4.1.    21 ,  0 1.xy xy x e y y              4.2.  22 ln ,  1 1 2.xy y y x y     

4.3.    22 ,  1 2.xy y xy y              4.4.    3 3 4 24 4 1 ,  0 1.xy x y x e y y      

4.5.    2 ln 2 ln ,  1 1.xy y y x x y         4.6.      22 1 , 0 2.xy xy x e y y      

4.7.    23 ln ,   1 3.xy y y x y            4.8.    23 ,  1 3.xy y xy y      
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4.9.  2 ln ,  1 1.xy y y x y             4.10.
22 23 2 2 ,  (0) 1.xy xy xy e y       

Задание 5. Решите дифференциальные уравнения. Постройте в одной 

системе координат интегральные кривые при целых значениях произвольной 

постоянной от  ‒1 до 1. 

5.1. 1) 2arcsin 1x y y y     ;   2) 
1 1

ln
2 1

y
y y

y


 


. 

5.2. 1) 22 arctg ln( 1)x y y y     ;   2) ch shy y y y    . 

5.3. 1) 2arccos 1x y y y     ;   2) 2( 2)sh 2 chy y y y y      . 

5.4. 1) lnx y y y    ;     2) ln | cos | tgy y y y    . 

5.5. 1) sin cosx y y y    ;    2) 
6 6

ln
6 36

y y
y y

 
  . 

5.6. 1) ch shx y y y    ;    2) 
2 1

arctg
2 2

y y
y y

 
  . 

5.7. 1) sh 2x y y   ;     2) lny y y y    . 

5.8. 1) cos sinx y y y    ;    2) 21
ln( 4)

2
y y  . 

5.9. 1) sh chx y y y    ;    2) 
31
(3ln 1)

9
y y y   . 

5.10. 1) ( 1) yx y e
  ;     2) ln | sin | ctg 1y y y y     . 

Задание 6. Найдите все решения уравнения. Постройте в одной системе 

координат график особого решения и интегральных кривых при целых 

значениях произвольной постоянной от  ‒3 до 3. 

6.1. 22 1y xy y    .     6.2. 2 1y xy y    . 

6.3. 2 1y xy y    .     6.4. 2 1y xy y    . 

6.5. 22 1y xy y    .     6.6. 22 2y xy y    . 

6.7. 22 2y xy y    .     6.8. 23 1y xy y    . 

6.9. 22 3y xy y    .     6.10. 23 1y xy y    . 
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Темы для самоконтроля 

1. Основные понятия теории дифференциальных уравнений 1-го порядка. 

2. Задача Коши для дифференциального уравнения 1-го порядка. Теорема 

существования и единственности решения. 

3. Уравнения с разделяющимися переменными и сводящиеся к ним. 

4. Однородные уравнения и сводящиеся к ним. 

5. Линейное уравнение 1-го порядка. 

6. Уравнение Бернулли.  

7. Уравнение в полных дифференциалах. 

8. Интегрирующий множитель 

9. Уравнения 1-го порядка, не разрешенные относительно производной. 

10 Уравнения Лагранжа и Клеро. 

 

Лабораторная работа №6  

Обыкновенные дифференциальные уравнения высших порядков 

 

Цель: научиться находить общее и частное решения некоторых 

уравнений высших порядков и контролировать результаты с помощью средств 

системы Maple. 

Задание 1. Решите уравнения и сравните с результатами, полученными в 

Maple. Постройте в одной системе координат несколько интегральных кривых. 

1.1.1) ;yx y e
     2) 

2 ctg 0;yy y yy x      

      3)  2 31 0;y y y      4) 
2 3 2

2 1
3 sin .

y y
y

x x x x

 
    

 
 

1.2.1) ln ;x y y      2) 
2 2( 1)( ) 2 ;x yy y xyy      

       3) ;yy xy e
      4) 

1

2 2

1
2 .x

y y
y e

x x x

 
    

 
 

1.3.1) 2 ln ;x y y      2) 
2 2arctg ( 1)( ) ;x x yy y yy      
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      3) ;y xy y       4) 
2

2 .
xy y e

y
x xx


     

1.4. 1) sin ;x y y      2) 
2ln ( ) ;x x yy y yy     

       3) 
6

;
6

y
y xy


      4) 

2

2( )
.xy xy

y e
x


    

1.5. 1) 2 cos ;x y y      2) 
2 th ;yy y yy x     

       3) 
10

;
10

y
y xy


      4) 

2 2

1 1
2 cos .

y y
y

x xx x

 
    

 
 

1.6. 1) sh ;x y y      2) 2 21 arcsin ( ) ;x x yy y yy      

       3) 2 ;xy y e      4) 4 5

2

4 4
25 sin .

y y
y x x

x x


     

1.7. 1) 2ch ;x y y      2) 
2sin cos ( 2 ;x x yy y yy     

       3) ln 0;y x x y      4) 
43

2

3 3
16 .xy y

y x e
x x


     

1.8. 1) 2ln ;x y y      2) 
2sin ( ) 3 cos ;x yy y yy x     

       3) tg 0;y x y      4) 
2 2

arcsin .
1

y y x
y x

x x x


    


 

1.9. 1) ;yx y e
     2) 

2sin ( ) 2 cos ;x yy y yy x     

        3)  21 arctg ;y x x y     4) 2 2

2
9 ln 3 .

y y
y x x x

x x


      

1.10. 1) ln ;x y y     2) 
2cos ( ) 2 sin 0;x yy y yy x      

         3) 21 arcsin ;y x x y     4) 
2

(1 ).xy y
y e x

x x


      

Задание 2. Найдите общее решение уравнения и сравните с результатом, 

полученным в системе Maple. 

2.1. ln .y x x y        2.2. 1.xy y    

2.3. 2 .xy y        2.4. 1.xy y x     
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2.5. 
1

tg 0.
sin

x y y
x

         2.6. 
2 1.x y xy    

2.7. ctg2 2 0.y x y        2.8. 
3 2 1.x y x y    

2.9. tg 2 .x y y        2.10. cth 2 2 .y x y   

Задание 3. Найдите общее решение дифференциального уравнения. 

3.1.  2 4 sin cos .xy y e x x      3.2. 
24 4 sin6 .xy y y e x      

3.3.  2 2 sin cos .xy y e x x       3.4. 2cos7 3sin7 .y y x x     

3.5. 2 5 sin 2 .y y y x        3.6.  4 8 5sin 3cos .xy y y e x x      

3.7.  2 sin cos .xy y e x x      3.8. 
24 4 sin3 .xy y y e x     

3.9. 
36 13 cos4 .xy y y e x      3.10. 2cos3 3sin3 .y y x x     

Темы для самоконтроля 

1. Дифференциальные уравнения высших порядков. 

2. Задача Коши. Теорема о существовании и единственности ее решения. 

3. Дифференциальные уравнения, допускающие понижение порядка. 

4. Линейный дифференциальный оператор и его свойства. 

5. Линейное однородное дифференциальное уравнение n-го порядка. 

Свойства его решений. 

6. Критерий линейной независимости решений линейного однородного 

уравнения. Фундаментальная система его решений. Структура общего решения. 

7. Линейное неоднородное дифференциальное уравнение n-го порядка. 

Структура общего решения. 

8. Линейное однородное уравнение с постоянными коэффициентами. 

9. Линейное неоднородное дифференциальное уравнение с постоянными 

коэффициентами и специальной правой частью. Подбор частного решения с 

помощью метода неопределенных коэффициентов. 

10. Метод Лагранжа (или метод вариации произвольных постоянных). 
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Лабораторная работа №7 

Системы дифференциальных уравнений 

 

Цель: научиться строить фазовый портрет нормальной системы 2-го 

порядка вблизи точки покоя, аналитически находить общее и частное решения 

линейных систем методами Лагранжа, Эйлера, Д’Аламбера и контролировать 

результаты с помощью средств системы Maple. 

Задание 1. Исследуйте поведение фазовых кривых системы уравнений 

вблизи точки покоя. Сделайте чертеж. 

Определите тип точки покоя по фазовому портрету и собственным 

значениям матрицы системы. 

Найдите общее решение системы и выделите фундаментальную систему 

решений. Сравните с результатами, полученными в Maple. 

Постройте в прямоугольной системе 1 2Oxy y  пространственные кривые, 

удовлетворяющие заданной системе и содержащие соответственно точки 

0 0
1 2(0, , )y y . Значения 

0 0
1 2,y y  возьмите те же, что использовались для построения 

фазового портрета. Сравните чертежи, полученные на плоскости и в 

пространстве. 

Перейдите от системы уравнений к однородному дифференциальному 

уравнению 1-го порядка относительно функции 2 1( )y y , постройте его поле 

направлений в окрестности особой точки. Сравните с фазовым портретом 

системы. 

1.1. 
1 1 2

2 1 2

2 2 ,

7 3 .

y y y

y y y

   

  

    1.2. 
1 1 2

2 1 2

3 5 ,

7 .

y y y

y y y

  

  

 

1.3. 
1 1 2

2 1 2

5 ,

12 9 .

y y y

y y y

  

  

    1.4. 
1 1 2

2 1

2 ,

3 .

y y y

y y

   

 

 

1.5. 
1 1 2

2 1 2

5 2 ,

15 8 .

y y y

y y y

   

   

    1.6. 
1 1 2

2 1 2

9 7 ,

3 5 .

y y y

y y y

  

  
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1.7. 
1 1 2

2 1 2

4 8 ,

3 6 .

y y y

y y y

   

   

    1. 8. 
1 1

2 1 2

3 ,

4 7 .

y y

y y y

 

  

 

1.9. 
1 1 2

2 2

3 ,

2 .

y y y

y y

   

 

    1. 10. 
1 1 2

2 1

2 ,

6 .

y y y

y y

   

 

 

Задание 2. Решите систему уравнений методом исключений и сравните 

результат с ответом, полученным в Maple. 

2.1. 
1 1 2

2 1 2

5 3 ,

4 9 .

y y y

y y y

  

  

     2.2. 
1 1 2

2 1 2

7 ,

5 3 .

y y y

y y y

  

  

 

2.3. 
1 1 2

2 1 2

4 13 ,

5 3 .

y y y

y y y

  

  

    2.4. 
1 1 2

2 1 2

4 ,

11 6 .

y y y

y y y

  

  

 

2.5. 
1 1 2

2 1 2

9 2 ,

6 5 .

y y y

y y y

  

  

    2.6. 
1 1 2

2 1 2

4 7 ,

2 .

y y y

y y y

   

  

 

2.7. 
1 1 2

2 1 2

3 2 ,

4 .

y y y

y y y

  

  

    2.8. 
1 1 2

2 1

4 3 ,

.

y y y

y y

  

  

 

2.9. 
1 1 2

2 1 2

5 2 ,

9 6 .

y y y

y y y

  

   

    2.10. 
1 1 2

2 1 2

3 12 ,

7 .

y y y

y y y

  

  

 

Задание 3. Решите задачу Коши с помощью методов Лагранжа и 

Д’Аламбера. Сравните с результатом, полученным в Maple. Сделайте чертеж. 

1.1. 

   

2 ,

2 1;

0 0, 0 5.

x x y

y x y

x y

 


  

 

   1.2. 

   

2 2 ,

4 ;

0 3, 0 1.

x x y

y x

x y

 


 

 

 

1.3. 

   

2 1,

3
;

2

0 1, 0 0.

x x y

y x y

x y

   



  

 

   1.4. 

   

3 5 2,

3 1;

0 0, 0 2.

x x y

y x y

x y

  


  

 

 

1.5. 

   

3 2 ,

5
2;

2

0 0, 0 1.

x x y

y x y

x y

 



  

 

   1.6. 

   

2 1,

2 3;

0 1, 0 0.

x y

y x

x y

 


 

  
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1.7. 

   

2 8 1,

3 4 ;

0 2, 0 1.

x x y

y x y

x y

  


 

 

   1.8. 

   

2 2 2,

4 1;

0 0, 0 1.

x x y

y y

x y

  


 

 

 

1.9. 

   

,

4 1;

0 1, 0 0.

x x y

y x y

x y

 


  

 

   1.10. 

   

2 1,

3 ;

0 0, 0 1.

x x y

y x

x y

  


 

 

 

Темы для самоконтроля 

1. Понятие нормальной системы дифференциальных уравнений. 

2. Задача Коши для системы дифференциальных уравнений. 

3. Метод исключений и интегрируемых комбинаций решения систем. 

4. Линейные системы. Матричная форма записи. Структура решения. 

5. Фундаментальная система решений однородной линейной системы с 

постоянными коэффициентами. 

6. Метод Лагранжа решения неоднородной линейной системы с 

постоянными коэффициентами.  

7. Метод Д’Аламбера решения неоднородной линейной системы 2-го 

порядка с постоянными коэффициентами. 

8. Фазовый портрет линейной однородной системы 2-го порядка вблизи 

точки покоя. 

9. Классификация простейших точек покоя линейной однородной 

системы 2-го порядка с постоянными коэффициентами на плоскости. 

10. Понятие устойчивости линейных однородных систем (по Ляпунову). 

 

Лабораторная работа №8 

Элементы операционного исчисления 

 

Цель: научиться находить изображение Лапласа для функций-

оригиналов, решать обратную задачу, применять операторный метод для 

решения задачи Коши линейных уравнений с постоянными коэффициентами и 
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их систем, контролировать полученные результаты с помощью средств системы 

Maple. 

Задание 1. По данному графику функции-оригинала найдите ее 

изображение Лапласа. Получите ответ в системе Maple и сравните результаты. 

1.1.         1.2. 

           

1.3.        1.4. 

    

1.5.         1.6.  

    

1.7.        1.8. 
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1.9.       1.10.  

    

Задание 2. Найдите оригинал по заданному изображению «вручную» и с 

помощью Maple.  

2.1. 
  2

4 5

2 4 5

p

p p p



  
.    2.2. 

  21 1

p

p p p  
. 

2.3. 
  21 4 5

p

p p p  
.    2.4. 

  2

5

1 2 5

p

p p p



  
. 

2.5. 
  2

3 2

1 4 5

p

p p p



  
.    2.6. 

  2

5

1 4 5p p p  
. 

2.7. 
  2

5

2 2 2

p

p p p  
.    2.8. 

  2

1

2 2 3p p p  
. 

2.9. 
  2

2 1

1 2 3

p

p p p



  
.    2.10. 

 2

1

3 3

p

p p p



 
. 

Задание 3. Найдите решение дифференциального уравнения, 

удовлетворяющее условиям  0 0y   и  0 0y  , операторным методом 

(используя интеграл Дюамеля) и методом Лагранжа. Сравните результаты и 

проконтролируйте их с помощью системы Maple.  

3.1. 
2

2
1

te
y y y

t
   


.     3.2. 

1

1 t
y y

e
  


. 

3.3. 
1

t

t

e
y y

e
  


.     3.4. 2

1

te
y y y

t
   


. 

3.5. 
2

3

t

t

e
y y

e
  


.     3.6. 

1

1 t
y y

e
  


. 
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3.7. 
1

t

t

e
y y

e
  


      3.8. 

2

2

t

t

e
y y

e
  


. 

3.9. 
2

2

t

t

e
y y

e
  


.     3.10. 2

1

te
y y y

t



   


. 

Задание 4. Операторным  методом решите задачу Коши и сравните с 

решением в Maple.  

4.1. 
   

6 ,

0 3, 0 1.

ty y e

y y

   


 

    4.2. 
   

24 29 ,

0 0, 0 1.

ty y y e

y y

    


 

 

4.3. 
   

3 2 ,

0 1, 0 0.

ty y y e

y y

    


 

    4.4. 
   

2 3 ,

0 1, 0 1.

ty y y e

y y

    


 

 

4.5. 
   

27 ,

0 1, 0 4.

ty y y e

y y

    


 

    4.6. 
   

2 3 3 ,

0 0, 0 1.

ty y y e

y y

    


 

 

4.7. 
   

33 2 12 ,

0 2, 0 6.

ty y y e

y y

    


 

   4.8. 
   

2 ,

0 1, 0 2.

ty y e

y y

   


 

 

4.9. 
   

2 ,

0 1, 0 0.

ty y y e

y y

    


  

   4.10. 
   

3 2 2 ,

0 1, 0 0.

ty y y e

y y

    


 

 

Задание 5. Решите систему дифференциальных уравнений операторным 

методом. Сравните с решением, полученным в Maple. 

5.1. 

   

3 2,

1;

0 1, 0 2.

x x y

y x y

x y

  


  

  

    5.2. 

   

3 1,

;

0 1, 0 2.

x x y

y x y

x y

   


 

 

 

5.3. 

   

4 ,

2 9;

0 1, 0 0.

x x y

y x y

x y

 


  

 

    5.4. 

   

2 1,

4 ;

0 0, 0 1.

x x y

y x y

x y

  


 

 

 

5.5. 

   

2 5 ,

2 2;

0 1, 0 1.

x x y

y x y

x y

 


  

  

    5.6. 

   

2 5 1,

2 1;

0 0, 0 2.

x x y

y x y

x y

   


  

 
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5.7. 

   

3 ,

5 3 2;

0 2, 0 0.

x x y

y x y

x y

 


   

 

    5.8. 

   

3 4 1,

2 3 ;

0 0, 0 2.

x x y

y x y

x y

   


 

 

 

5.9.

   

2 6 1,

2 2 ;

0 0, 0 1.

x x y

y x y

x y

   


 

 

    5.10.

   

2 3 1,

4 2 ;

0 1, 0 0.

x x y

y x y

x y

  


 

  

 

Темы для самоконтроля 

1. Понятие функции-оригинала. 

2. Интеграл Лапласа от функции-оригинала и его простейшие свойства.  

3. Теорема о подобии. 

4. Теоремы о запаздывании и смещении. 

5. Дифференцирование оригинала и изображения. 

6. Интегрирование оригинала и изображения. 

7. Свертка функций и ее свойства. Теорема о свертке. 

8. Интеграл Дюамеля. 

9. Нахождение оригинала по изображению. 

10. Операторный метод решения задачи Коши для линейных однородных 

уравнений с постоянными коэффициентами и их систем. 

 

Лабораторная работа №9 

Элементы комплексного анализа 

 

Цель: научиться решать простейшие задачи теории функций 

комплексного аргумента и контролировать полученные результаты с помощью 

средств системы Maple. 

Задание 1. Найдите все значения корня «вручную». С помощью системы 

Maple проконтролируйте полученные результаты и постройте точки, 

соответствующие найденным значениям, в комплексной плоскости. 

1.1. 4 1.       1.2. 4 .i  
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1.3. 4 1.       1.4. 4 .i  

1.5. 4 16.       1.6. 4 16. 

1.7. 4 16 .i       1.8. 4 16 .i  

1.9. 4 81.       1.10. 4 81.  

Задание 2. Представьте выражение в алгебраической форме. Изобразите 

точки, соответствующие аргументу и значению функции, в одной системе 

координат. 

2.1. sin 2 .
4

i
 
 

 
     2.2. cos 2 .

6
i

 
 

 
 

2.3. sh 2 .
4

i
 

 
 

    2.4. ch 2 .
2

i
 

 
 

 

2.5. sin .
3

i
 
 

 
     2.6. cos .

4
i

 
 

 
 

2.7. sh 1 .
2

i
 

 
 

    2.8.  ch 1 .i  

2.9. cos 2 .
4

i
 
 

 
    2.10. sin 5 .

2
i

 
 

 
 

Задание 3. Представьте выражение в алгебраической форме и получите 

его главное значение в системе Maple. 

3.1. 
 1 3 1

Arctg .
3 1

i

i

 

 
   3.2. Arcsin4. 

3.3. 
2 3 3

Arctg .
3

i  
 
 

   3.4. 
4 3

Arcctg .
5

i 
 
 

 

3.5. 
3

Arcsin .
4

i 
    3.6. 

17
Arcsin .

8
 

3.7. Arctg .
3

i 
 
 

    3.8.  Arctg 2 .i  
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3.9. Arccos( 5).     3.10. 
1 3

Arcsin .
2

i
 

Задание 4. Изобразите области, заданные неравенствами. 

4.1. 1) 1 1, 1 2;z z       2) 1, 0 arg .
4

z i z


     

4.2. 1) 1, 2;z i z       2) 1, arg 0.
4

z i z


      

4.3. 1) 1 1, 1;z z i       2) 1 1, arg .
4

z i z


     

4.4. 1) 1 1, 1;z z i       2)  2, arg 1 .
4 4

z z
 

      

4.5. 1) 2, 2;z i z i       2)  1, arg .
4

z z i


    

4.6. 1) 2, Re 1;z i z      2) 2, Re 1, arg .
4

z z z


    

4.7. 1) 1 1, Im 1, Re 1;z i z z        2) 
3

1, arg .
4 4

z i z
 

       

4.8. 1) 1 1, Re 1, Im 1;z i z z       2)  1, arg .
2 4

z i z i
 

       

4.9. 1) 2 1, Re 3, Im 1;z i z z       2)  1 1, arg , arg 1 .
4 4

z z z
 

      

4.10. 1) 2, 0 Re 1;z i z       2)  1, arg , arg 1 .
4 4

z i z z i
 

       

Задание 5. Определите вид кривой. Сделайте чертеж в Maple. 

5.1. 3sec 2 tg .z t i t      5.2. 2sec 3 tg .z t i t   

5.3. sec 3 tg .z t i t       5.4. 4tg 3 sec .z t i t   

5.5. 3tg 4 sec .z t i t      5.6. 4tg 2 sec .z t i t    

5.7. 3cosec 3 ctg .z t i t     5.8. 4cosec 2 ctg .z t i t   

5.9. ctg 2 cosec .z t i t      5.10. ctg 3 cosec .z t i t    
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Задание 6. Восстановите аналитическую в окрестности точки 0z  

функцию  f z  по известной действительной  ,u x y  или мнимой  ,v x y  части 

и значению  0f z . 

6.1.  2 2 , 0 0.u x y x f       6.2.  2 2 2 , 0 0.u x y y f     

6.3.  2 2 2 1, 0 .v x y x f i       6.4.  2 2 2 1, 0 1.u x y x f      

6.5.  2 2 , 0 .u xy y f i        6.6.  2 , 0 0.v xy x f    

6.7.  2 , 0 0.u y xy f      6.8.  2 33 , 0 0.v x y y y f     

6.9.  3 23 1, 0 1.u x xy f       6.10.  2 2 , 0 0.v x y x f     

Задание 7. Вычислите интеграл от функции комплексного аргумента по 

заданному множеству L. Получите ответ в Maple. Сделайте чертеж. 

1.1. 
3 5

; : 2, arg .
4 4

L

z dz L z z
  

   
 

  

1.2.    1 ; : 1, Re 0 .z

L

z e dz L z z    

1.3.  ; : 4, Re 0 .
L

z zdz L z z   

1.4.    ch ; : 1, Im 0 .
L

z z dz L z z    

1.5.  2Re ; : 2, Im 0 .
L

z z dz L z z   

1.6.    3 sin ; : 1, Re 0 .
L

z z dz L z z    

1.7.    2cos 3 ; : 1, Im 0 .
L

iz z dz L z z    

1.8.  ; : 1, Im 0 .
L

z z dz L z z   

1.9.  2Re ; : , Im 0 .
L

z z dz L z R z   

1.10.    sin ; : 1, Re 0 .
L

iz z dz L z z    
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Задание 8. Найдите все лорановские разложения заданной функции по 

степеням z . Сравните с результатом, полученным в системе Maple. 

8.1. 
4 3 2

4
.

2

z

z z z



 
    8.2. 

4 3 2

2 16
.

2 8

z

z z z



 
  

8.3. 
4 3 2

3 36
.

3 18

z

z z z



 
    8.4. 

4 3 2

5 100
.

5 50

z

z z z



 
 

8.5. 
4 3 2

6 144
.

6 72

z

z z z



 
    8.6. 

4 3 2

7 196
.

7 98

z

z z z



 
 

8.7. 
4 3 2

8 256
.

8 128

z

z z z



 
    8.8. 

2 3 4

4
.

2

z

z z z



 
 

8.9. 
2 3 4

2 16
.

8 2

z

z z z



 
    8.10. 

2 3 4

3 36
.

18 3

z

z z z



 
 

Задание 9. Найдите все лорановские разложения данной функции по 

степеням 0z z . Сравните с результатом, полученным в системе Maple. 

9.1. 
  0

1
, 1 2 .

1

z
z i

z z


 


    9.2. 

  0

1
, 2 3 .

1

z
z i

z z


 


 

9.3. 
  0

1
, 3 2 .

1

z
z i

z z


  


   9.4. 

  0

1
, 2 .

1

z
z i

z z


  


 

9.5. 
  0

1
, 1 3 .

1

z
z i

z z


 


   9.6. 

  0

1
, 2 .

1

z
z i

z z


 


 

9.7. 
  0

1
, 1 2 .

1

z
z i

z z


  


   9.8. 

  0

1
, 2 3 .

1

z
z i

z z


  


 

9.9. 02

3
, 2 .

1

z
z i

z


 


    9.10. 02

3
, 3 .

1

z
z i

z


 


 

Задание 10. Заданную функцию разложите в ряд Лорана в окрестности 

точки 0z . Сравните с результатом, полученным в системе Maple. 

10.1. 0

1
cos , 2.

2
z z

z



    10.2. 0sin , 1.

1

z
z

z



 

10.3. 0cos , 3.
3

z
z z

z



    10.4. 0

2 7
sin , 2.

2

z
z

z


 


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10.5. 0

3
cos , .

z
z i

z i



    10. 6. 0

5
sin , 2 .

2

z
z i

z i



 

10.7. 0

3
sin , .

3 3

z i i
z

z i


 


    10.8. 0

2
sin , 4.

4

z
z

z



 

10.9. 0sin , 1.
1

z
z z

z



    10.10. 0sin , 3.

3

z
z

z



 

Задача 11. Вычислите интеграл. Сравните с результатом, полученным в 

системе Maple. 

11.1. 
 2

1

2

.
1

z

dz

z z



     11.2. 

 2
5

1
4

2
.

1
z i

dz

z z
  


  

11.3. 
 2

3

2

.
4

z i

dz

z z
 


     11.4. 

 1

2 sin
.

2
z

z
dz

z z i





  

11.5. 
1

3
2

.
sin

z

z

e dz

z
 

      11.6. 
 

3
2

2

sin 2
.

sin
z

z z
dz

z
 


  

11.7. 
1 3

.
sin

z

z

ze
dz

z
 

     11.8. 
3

2
2

2 1
.

sin
z

z z
dz

z
 


  

11.9. 
 

2

1 1

4 3

1
.

sin 2
z

z z
dz

z
 




     11.10. 

 

1
1

2

.
sin

z

iz z i
dz

z
 




  

Задание 12. Вычислите интеграл. Сравните с результатом, полученным в 

системе Maple. 

12.1. 
2

3
1

cos 1
.

z

z
dz

z


     12.2. 

2 3

3

1

2

2 3
.

4
z

z z
dz

z


 
  

12.3. 

1

3

1
.

z

z

e
dz

z



      12.4. 

3

2

sin
.

1 cos
z

z
dz

z



  
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12.5. 
2 3

2
1

3

1 2 3 4
.

2
z

z z z
dz

z


  
    12.6. 

2

2
2

1 cos
.

z

z
dz

z


  

12.7. 
4 3

4
1

3 2 5
.

z

z z
dz

z

 
    12.8. 

3

1
1 sin

.
z

z dz
z





  

12.9. 

22

3
1

2

1
.

z

z

e
dz

z



     12.10. 

4

3
1

3

3 2 4
.

z

z z
dz

z


 
  

Задача 13. Вычислите интеграл. Сравните с результатом, полученным в 

системе Maple. 

13.1. 
2 2 2

0,2

3 sin3
.

shz

z z
dz

z z

  

 
    13.2. 

2

4
1

cos3 1 9
2 .

9
sh

4
z

z
z

dz

z z

 

  

13.3. 
2

2 20,5

sh 2 2
.

sin
3

z

z z
dz

z
z

  


    13.4. 

2

42

ch3 1 9
2 .

9
sin

8
z

z
z

dz
z

z

 

  

13.5. 
2

2
0,5

1 2
.

sh 4

z

z

e z
dz

z iz

 
    13.6. 

4

0,4

cos7
.

sh

z

z

e z
dz

z z





  

13.7. 
8

0,2

ch 4
.

sin 4

z

z

e z
dz

z z



     13.8. 

2
0,1

ch cos3
.

sin5z

z z
dz

z z




  

13.9. 
3

0,2

sh3 sin3
.

sh 2z

z z
dz

z z


    13.10. 

4

3
0,05

1 sin 4
.

sh16

z

z

e z
dz

z z

 


  

Задание 14. Вычислите интеграл. Сравните с результатом, полученным в 

системе Maple. 

14.1. 
2

0

.
2 3sin

dt

t




    14.2. 

2

0

.
4 15 sin

dt

t




  

14.3. 
2

0

.
5 2 6 sin

dt

t




    14.4. 

2

0

.
6 35sin

dt

t




  
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14.5. 
2

0

.
7 4 3sin

dt

t




    14.6. 

2

0

.
5 4sin

dt

t




  

14.7. 
2

0

.
5 3sin

dt

t




     14.8. 

2

0

.
8 3 7 sin

dt

t




  

14. 9. 
2

0

.
9 4 5 sin

dt

t




    14.10. 

2

0

.
4 7 sin

dt

t




  

Задание 15. Постройте образ квадрата, прилежащего к координатным 

осям комплексной плоскости, с вершиной в точке (2, 2)A  при заданном 

преобразовании. Сделайте чертеж в системе Maple. 

15.1. 
2 2 3z z z   .    15.2. 

2 3 4z z z   . 

15.3. 
2 4 3z z z   .    15.4. 

2 5 4z z z   . 

15.5. 
2 3 5z z z       15.6. 

2 5 2z z z   . 

15.7. 
2 3 2z z z   .    15.8. 

2 4 5z z z   . 

15.9. 
2 2 5z z z   .    15.10. 

2 3 4z z z   . 

Темы для самоконтроля 

1. Комплексные числа и действия над ними.  

2. Предел последовательности комплексных чисел. 

3. Функции комплексного аргумента. Основные элементарные функции. 

4. Предел и непрерывность функции комплексного аргумента. 

5. Дифференцирование и интегрирование функции комплексного 

аргумента. Условия Коши – Римана. 

6. Ряды в комплексной области. Нули и изолированные точки функции. 

7. Интегральная формула Коши. 

8. Вычеты функций. Теорема Коши о вычетах. 

9. Приложение вычетов к вычислению определенных интегралов. 

10. Конформные отображения. 
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